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Before Using Camera

942P features approximately 8.1 Mega Pixel CMOS

Auto-focus Camera capable of capturing still images and

videos.

® Use Variety Photo Viewer (C% P.10-24) for viewing still images or
slideshow.

I Image File Formats

Still images/videos are saved to Data Folder.

Image Type File Format Save Location
Still images JPEG (.jpg) Data Folder (Pictures)

’ MPEG-4 (.3gp), -
Videos ASF (.asf) Data Folder (Videos)

@ To save to microSD Card, change Storage setting (C3P.18-17, P.18-18).

\H

I Notes

® Remove dust/debris from lens cover with a soft cloth.

@ Handset movement may blur images especially in dark places; hold
handset firmly.

® Capturing/saving images immediately after handset has been left in a
hot place may affect image quality.

® Exposing lens to direct sunlight may affect image quality.

® While Camera is active, Photo light illuminates or flashes. Photo light
cannot be turned off.

Shutter Click
Shutter click sounds at fixed volume even in Manner Mode.
® To change shutter click sound: L5 P.18-17, P.18-18



I Camera

Press (@) in Standby to activate Camera. Press and hold (1)
to activate Video Camera. Use Flash when shooting in dark
locations.

\H

® Alternatively, to activate Camera:
- From Main Menu > Camera > Camera or Video Camera
- Press and hold () (xw)
- Open handset to Horizontal Open Position from Standby (Horizontal

View: C#P.18-14)

® Camera is not available when battery is low.

® Incoming calls, Alarm and low battery cancel Camera. Captured images/
recorded videos are retained. Save data when Camera restarts.

® When left in Viewfinder for three minutes, Camera is canceled and
previous window returns.
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I Camera Display Indicators

® |mages shown below are for reference only.
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Item

Description

Operation

Photo mode (% P.6-9)

& intelligent Auto [ Normal B Scene 3™ My original set.
(For Scene/My original set., indicators may vary depending on setting.)

Press and hold (=2)[ -] — Select a mode

(—» For Scene/My original set., select an item)

CHG Camera-mode & Camera mode B Video camera mode & /& / & Action mode (Auto/ | (a)[Video/Cont./Camera]
Auto bracket/Manual) (Cont. shooting set.: £3 P.6-6) @ Toggle Action mode (C5P.6-10)
Storage setting i3] Phone E¥ microSD Card @

No. of frames

Show number of remaining frames

Img. stabilizer

Correct camera shake

(C5P18-17,P.18-18)

Flash setting (Still image) P Auto [ Forced ON EE Always light ON' @ Forced OFF §

Photo light setting (Action/Video) | & ON E& OFF

Key Guidance Show key operation guidance —
Top indicator Indicate vertical direction —
Focus Guide I Auto focus quide BNl AF tracking quide —
Auto shutter' (C¥P.6-7) [N Love shutter (Sweetheart) Love shutter (Friends) FIF¥F Group shutter (Group)| ()

Zoom bar

Indicate zoom level (C%P.6-8)

(/o) zoominfout @ Long press: continuous zoom

Image size’

Show image size (C3P.6-8)

Image quality?

(1) - Select a size

I Normal Fine Super fine

—> Select a mode

High sensitiv.?

ON P33 OFF

— Select ON/OFF

Brightness? Adjust brightness (Level -3 to +3) —> Select a level
White balance? A Auto Bl Fine XX Cloudy BBl Light bulb [Exll Fluorescent light — Select a mode
Scene? X Portrait Sports 8l Food [ Scenery Night mode | (&) —» Select a scene

BBl Backiight = Character P Snow B Sunset Pet

Focus? (CFP6-11)

I Face Detection Auto [N Close-up IF¥ Landscape AF tracking

(B) —» Select a mode

Auto timer

(C%P6-7)

— Toggle ON/OFF

Memory capacity bar

Indicate memory status (appears in red when memory is full)

File size setting

£ Mail restrict'n(S) & Mail restrict'n(L) B3 Long time

(C%P.18-18)

Movie type set

Record video without audio

(CP.18-18)

BB OBB66 666066 6eBseoee 0% o e

Recordable time

Indicate recordable time

! Key Guidance appears when Photo mode is set to Intelligent Auto and Auto shutter is not set.
2 Alternatively, (=2)[ I = 699 to highlight an item —» () to select a setting

P
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Pictures/Videos

@ Confirm battery strength (C%P.1-11) and memory (C¥P.18-17, P.18-18)
before recording. When battery is low, video cannot be recorded.

® Captured images and videos are automatically saved to Data Folder. To
select save location each time, turn Auto save set to OFF (C#P.18-17,
P.18-18).

® QOperation descriptions are based on Portrait View.

® For capturing images by ()@, press firmly.

I Capturing Still Images (Camera Mode)
1 (a) or press and hold () ()

Picture Viewfinder appears.

2 Frame subject

Picture Viewfinder

3 (@][Record], () or ()(1®) to capture the image

Shutter click sounds at fixed volume.

Image is automatically saved.

® When Focus is set to Face Detection, Auto or AF tracking,
Camera automatically focuses on subject before capturing image.

4 (=) to exit

Return to Standby.
Continuous Shooting

Capture a succession of up to 20 still images automatically

with a single press.

® Number of captured images differs depending on image size and
Continuous shooting setting (L3 P.6-10).

In Picture Viewfinder, @[Video] - @[Cont.]
& appears (Indicators vary by Action mode).

2 Frame subject (@)[Record], (0D or ()(xw)

Images are automatically saved.

® When Focus is set to Auto, Camera automatically focuses on
subject before capturing image.

® To stop shooting halfway:



I Recording Videos (Video Camera Mode)
1 Pressand hold ()

Video Viewfinder appears.

2 Frame subject
3 (@)[Record], (0D or ()@ to

start recording

Tone sounds and @REC appears.

® When Focus is set to Face Detection
or Auto, Camera automatically focuses
on subject before recording begins.
During recording, auto focus functions
regardless of Focus setting.

4 (@)Stop], () or () to end recording

Tone sounds.
Video is automatically saved.
@ Recording stops automatically at maximum recording time.

5 (=) to exit

Return to Standby.

Video Viewfinder

® Alternatively, (@) & (a)[Video] to activate Video Camera

\H

I Functions Available while Shooting

(From B Camera mode: (@)
Action mode: () p> (a)[Video] p> (tx)[Cont.]

Video camera mode: Press and hold ()

M Auto Timer

> [Menu] — Auto timer = ON — Enter time (seconds) =
(@)[Record], (0 or ()@ (= Forvideo, (@)[Stop], (O or ()xw)

® Auto timer tone sounds. After set period of time, shutter is released and
recording starts.

® When Auto timer is active, [Quit] or to return to Viewfinder
without canceling Auto timer.

® Auto timer is not available when Cont. shooting set. is set to Manual.

I Auto Shutter (Camera Mode Only)

Shutter automatically releases upon detecting number of people or distance
between people (When Photo mode is set to Intelligent Auto or Focus is
set to Face Detection).

> [Menu] — Auto shutter —» Select an item (See below)

Item Operation/Description

OFF Cancel Auto shutter setting

Love shutter Shutter releases when two faces move close together.
> Friends or Sweetheart
® \When Sweetheart is set, distance between two faces

is closer than Friends.

Group shutter Camera detects up to five faces. When more people are in
frame, Auto timer activates and shutter releases in three
seconds.
> Select number of people

® Alternatively, capture still images by (@)[Record], (0D or (_)(m¥) even
when Auto shutter is set (Auto timer activates for Group shutter.).

P
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M Zoom

> (09 (zoom in) or f©) (zoom out) to adjust zoom = (@)[Record],
() or (Jw

® For continuous zoom: Press and hold (o

® 7oom is available during video recording.

® Zoom may change image quality.

® Maximum zoom levels per image size are as follows.
Maximum zoom levels in Horizontal Open Position are indicated in () if
different from those in Normal Position.

\H

Camera mode Size Zoom level | Zoom Ratio*
Continuous A VGA 1-21 2.6x
shooting QVGA 1-31 5.1

[, T foldlz 1-31 8.5x
M sub-QCIF 1-31 12.8x
Video camera | I VGA 1-21 1.9%
(Img. stabilizer: HVGA Wide 1-21 1.9x
Auto) QVGA 131 2.9 (3.8)x
W Qi 1-31 5.2 (6.4)x
M sub-QCIF 1-31 7.2 (9.6)x
Video camera | VGA 1-21 2.6x
(Img. stabilizer: HVGA Wide 1-21 2.6x
OFF) QVGA 1-31 3.8(5.1x
[, . foldlz 1-31 7.0 (8.5)
M Sub-QCIF 1-31 9.6 (12.8)x

Camera mode Size Zoom level | Zoom Ratio*
Camera EH sm 1-21 2.6x
(High sensitiv.: 6M Wide 1-21 2.6x
OFF) B 5 121 2.6x

3M 1-21 2.6x
2M Wide 1-21 2.6x
2M 1-21 2.6x
Stand-by 1-21 2.6x
KA vea 1-21 2.6x
B QvGa 1-31 5.1x
B QarF 1-31 8.5x
Sub-QCIF 1-31 12.8x
Camera M 1-21 2.6x
(High sensitiv.: | I Stand-by 1-21 2.6x
ON) K VA 121 2.6x
EH qvea 1-31 5.1x
W QCiF 1-31 8.5x
Sub-QCIF 1-31 12.8x

* Values are approximates.
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I Use Flash/Photo Light

Select a Flash/Photo Light setting.

> In Picture Viewfinder, [Menu] — Flash setting — Select an item
(See below)

I Set Photo Mode According to Scene
> (¥7)[Menu] = Photo mode — Select an item (See below)

Item Operation/Description
Auto Flash goes off automatically in low-light situations.
Forced ON  Flash always goes off when capturing images.
Always light  Photo Light illuminates.
ON
Forced OFF  Flash/Photo Light is disabled.

> In Continuous Shooting/Video Viewfinder, (37)[Menu] —» Photo light set.
— ON or OFF

@ Flash/Photo light is not available when battery is low.

® When Camera is ended while a setting other than Forced OFF is set,
Flash setting is changed to Auto next time Camera activates. When
Forced OFF is set, setting remains.

® Even if Forced OFF (Flash setting) or OFF (Photo light set.) is set, Photo
light illuminates or flashes when Camera is active or during shooting.

® When Photo mode is set to Intelligent Auto, Forced ON cannot be
set.

® When using flash, maintain an appropriate distance from subject of 40
to 100 cm.

® When image is captured at close range or your hand is too close to
Flash/Photo Light, image color and brightness may differ in appearance
from actual subject.

Item Operation/Description
Intelligent  Automatically switch Photo mode according to occasion
Auto (in Camera mode)
@ |ndicator is animated when mode changes (Example:
B Close-up).
@ Mode does not change after Auto Focus Lock. Cancel
Auto Focus Lock.
Normal Capture an image in normal mode
Scene Adjust brightness and color tone according to scene
> Select an item
My original  (C¥P.6-10)

set.
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I Change Continuous Shooting Settings
> (x7)[Menu] = Cont. shooting set. = Select an item (See below)

Item Operation/Description

I Save as Original Setting
> Press and hold —» Photo mode MyOriginal — Follow the steps
(See below)

Action mode > Select an item
- Auto: Capture multiple still images automatically™
- Manual. Capture one by one manually
- Auto bracket: Capture nine different still images
automatically

Item Operation/Description

Save setting > Highlight a setting —= (&@)[Save] (> YES) = Edit

title

Open setting > Select a setting

Select an interval when Action mode is set to Auto
> Select an interval

Shot interval

Edit title > Highlight a setting = (=)[Edit] = Edit title
View detail > Highlight a setting = (37)[Detail]

Shot number Set number of images when Action mode is set to Auto
or Manual
> Select a number

Delete setting > Highlight a setting — (aa)[Delete] = YES

* Savable number of images is as follows:
- VGA (480x640): 4
- QVGA (240x320): 5t0 10
- QCIF (144x176): 5 to 20
- Sub-QCIF (96x128): 5 to 20

@ Save up to three settings each in Camera mode and Action mode.



Focus Functions
I Changing Focus Settings

<Default> Camera mode/Video camera mode: Face Detection
Action mode: Auto

Select a focus setting to suit the subject/occasion
(Unavailable when Photo mode is set to Intelligent Auto).
® Face Detection: Focus locks on faces
(Camera mode/Video camera mode only)
® Auto: Auto focus
® (Close-up: Focus for close-ups
@ Landscape: Focus on distant landscapes
® AF tracking: Focus on moving subject (Camera mode only)

1 InPicture/Video Viewfinder, ()
2 (&) toselectan item - (@)
_Note |

® Camera focuses on subject at a distance of over 10 cm.

® When Photo mode is set to Intelligent Auto, toggle current focus
setting and AF tracking by (B).

® While Camera is focusing, Focus sound is heard in the following
situations:
- When Focus setting is set to AF tracking
- When Photo mode is set to Intelligent Auto
- During video recording

Face Detection

® Detect up to five faces within 2.5 meters.

® Show yellow Focus Guide when a face is detected.

® Automatically focus on one face when more than one is detected
(Focus guide turns yellow once focus is on the face.).

® Faces may not be detected in following conditions:
- Face is tilted.
- A part of face is covered by glasses, hat, mask or shadow.
- Face is too small, big or dark for screen.
- Face is at edge of screen.
- Subject or handset moves too fast.

® Shoot with Auto focus if detection fails.

AF Tracking

Position AF tracking guide on subject and press (Q). Yellow AF tracking

guide appears and tracks moving subject while adjusting focus and

exposure for subject. During AF tracking, press (e)[Record], (O or

()@ to lock focus on subject and capture an image.

® Alternatively, press ()@ halfway to lock focus, then ()@ to
capture an image

® To cancel AF tracking: (@) or

® When Camera is unable to track subject (e.g. when subject is out of
Viewfinder), AF tracking is canceled.

@ Depending on situation, AF tracking may track unintended subject.

® AF tracking is not available when Auto shutter is in use or certain
image size is set.
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IAuto Focus Lock

Bring focus on subject at center of display automatically.
Lock focus on subject, and recompose your picture.

1 In Picture/Video Viewfinder, @ or ( (o
halfway
(@ When in focus, handset sounds.
@ Focus Guide turns green, and focus is locked.
® When out of focus, Focus Guide turns red.

® To cancel focus locked by (2) or G6):
® To cancel focus locked by () (@): Release finger from () ()

2 Determine composition

3 Capture image in selected camera mode (Camera mode:

% P.6-6/Action mode: 5 P.6-6/Video camera mode;
%P6-7)

® In Step 1, press () (@) halfway to lock focus, then press () ()
firmly to shoot.

Y

Viewing Saved Images

Main Menu > Camera

1 Open Pictures

Pictures ‘B &

Open Videos mé:zumozgmguum
. il

Videos

2 Select a folder
3 Select a file

R

Example: Pictures

M Open Pictures Saved on microSD Card
> In Step 1, Pictures — (&@)[microSD] = Select a folder

I Open Videos Saved on microSD Card
> In Step 1, Videos —» (@)[microSD] — Select a folder

I Check Still Images in Picture Viewfinder
> In Picture Viewfinder, (&@)[Folder]
@ To return to Picture Viewfinder:

P eececcccccccccccccoccccoe
@Cditing Still Images (C%P.10-11)
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Mobile Widget (Japanese)

Paste widgets to Standby to access information or tools

from Standby.

® Activating Mobile Widget enables Touchpad. Touchpad Indicators
illuminate (Touchpad Operations: L5 P.1-23, P.1-24).

Network Widget

Some widgets may periodically connect to network, incurring packet

transmission fees.

® While widgets appear in Standby, updated information for some
widgets may be automatically retrieved. During transmission, other
functions (e.g. Video Calls) may be disabled.

M Show/Hide Widget
> In Standby, (=)

[P ececcccccccccccccccccee

(ETTD @Set Touchpad to Activate for Web Browser/Mobile Widget
(FP18-7)
@Deactivate Auto Update @Activate Auto Roaming Abroad
@Hide Confirmation when Roaming Abroad @Forbid Sending/
Receiving Cookies @Delete Cookies @Change Pointer Speed
(P18-19)

Using Widgets
I Pasting Widgets to Standby

Paste up to five widgets per sheet. Select from four sheets
and organize sheets by theme.

1
Widget List appears.
7 Highlight a widget - (&2)[Paste] = Select a sheet

3 B39 to move to target location — (@]

I Delete Widgets from Standby Display
>Main Menu P> Widget P> Settings »> Delete Content
P> Select a sheet P> Check Contents to delete P> (=2)[Release] > YES

® Alternatively, Main Menu P> Widget
»> Widget Contents or Main Menu > Data Folder
p Widget to select widgets

® When saving widgets from microSD to Standby, do not remove microSD
Card.




I Activating Widgets
Selecting Widgets in Standby
1 InStandby (widgets shown), (B)

Pointer ( [t ) appears.
® To disable pointer: (=) or
2 $34 to move pointer = Select a
widget
Follow onscreen instructions.

M Toggle Sheets

> In Standby, (B) = (&@)[Back] or (c)[Forward] 3

\H

2/ 5(Fri]1D:1D

Selecting Widgets from Widget List

1 [EREADTrur |
Widget List appears. p

2 Select a widget — (@)

Widget List

B Move Widgets in List
> (@) - Highlight a widget = (7)[Move] — §34 to determine a target
location = (@)[OK]

196pIm 3j1qo N H
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I Downloading Widgets I Arranging Widgets in Standby
Main Menu P> Widget 1 In Standby, (T) —» 639 to move pointer to a widget
. —»
1 Widget Store [&)[Operate]
Handset connects to the Network, and download site appears. 2 Select an item (See below)
Follow onscreen instructions.
Installing Widgets Item Operation/Description
Some widgets may require you to install them manually; follow steps Move > B89 to move to a target location = (o)
= below: Delete frm > YES
=3 > In download completion window, (7)[Menu] = Install Standby
= ® Once installation is completed, widgets appear in Widget List. Widget Forward Move overlapping widget to foreground
= folder in Data Folder includes widgets that are not yet installed. Rear Move overlapping widget to background
% Reload Update widget
- ® Alternatively, Main Menu P> Widget »> Widget Contents
» Download Widget »> YES or Main Menu > Data Folder
» Widget » Download Widget p> YES to download
7-4
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S! Information Channel/Weather
(Japanese)

Subscribe to content and periodically receive updates. Set
Weather Indicator to appear on Standby.

® Transmission fees apply for updates.

® Auto download is not available overseas.

I Registering/Canceling

Main Menu P> News/Entertainment P> S! Info Ch./Weather
1 Register/Cancel = YES

Handset connects to the Network.
Follow onscreen instructions.

I Using S! Information Channel
® Up to seven updates are saved.

Viewing New Information

=

B E)

2/ 5(Fri]1D:1D

When information arrives, j, and Event
Indicator appear in Standby.

In Standby, (T) = 639 to move

1
pointer = Select Event Indicator Ko
™BD

2 @[Select] __New S! Info Channel
Follow onscreen instructions. ' A » / a1 y .
® Option Menu ltems (C5 P.8-4) R

Il Manually Retrieve Information
Select Event Indicator "Failed to download"
® Alternatively, Main Menu P> News/Entertainment
P> S! Info Ch./Weather p> Get Latest Contents p> YES

M Delete Information
> Main Menu P> News/Entertainment P> S! Info Ch./Weather
P> Highlight What's New? P> (%7)[Menu] ) Delete ) YES

® Alternatively, Main Menu p News/Entertainment
P> S! Info Ch./Weather p> What's New? to retrieve information

@ |f there is unread information in both S! Quick News and S! Information
Channel, fE does not appear. Only Event Indicator appears.

Viewing Previously Received Information

Main Menu » News/Entertainment p> S! Info Ch./Weather

History —» Select a date
C&L for unread news and &7 for read news appear.

I Delete History

> Main Menu P> News/Entertainment P> S! Info Ch./Weather
> History »> (Highlight a history) P> (37)[Menu] p> Delete or
Delete all p> YES ( > For Delete all, enter Phone Password)
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I Using Weather Indicator

Weather Indicator for current forecast area appears in
Standby.

Viewing New Information

Event Indicator and Weather Indicator appear for weather
updates.

1 Standby, (B) —» 639 to move
pointer = Select Event Indicator or

Weather Indicator

=

E]
2/ 5CFrid10:10

(@)[Select] /]
2 TBD;
nformation appears. T |
Follow onscreen instructions. v TR

® Option Menu ltems (C% P.8-4)

Weather Indicator

Indicators are updated periodically.

Example: “@: Clear, 4™ [>> < Rain later thunderstorm,

a< J r:s‘ Cloudy with occasional snow, etc.

@ See \Weather Indicator List (% P.19-24) for a complete list of
indicators.

B Manually Update Weather Indicator

Select Event Indicator "Failed to download"

® Alternatively, Main Menu P> News/Entertainment
P> S! Info Ch./Weather p> Weather Indicator p> Manual Update
> YES

I Hide Event Indicator
> Main Menu P> News/Entertainment p> S! Info Ch./Weather
P> Weather Indicator P> Missed Event Settings > OFF

® Alternatively, view forecast details from Main Menu
» News/Entertainment P> S! Info Ch./Weather
) Weather Indicator P> Weather

Hiding Weather Indicator

Main Menu » News/Entertainment p> S! Info Ch./Weather
P> Weather Indicator p> Display Settings

OFF
® When Display Settings is set to OFF, update is also deactivated.

JUBWIUIRLIBIUT/SMAN | CO
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I Option Menu Items

Open information and press (¥7)[Menu] for these options.

Item Operation/Description
Forward Go to next page
Text Copy Copy page text
Select File  View, play or save file to Data Folder (From Step 2 in

Downloading Image/Sound Files: £%P.15-11)

Jump in this
page

Jump to top/end of page

Yahoo! Keitai View top menu

Font Size* Change character size
Exit viewing  Exit content
this

* Linked with Font Size setting in Internet option menu.

\H

S! Quick News (Japanese)

Add news headlines, weather forecasts, etc. via S! Quick

News List to scroll across Standby Window.

® Registering or viewing S! Quick News incurs transmission fees. No fees
apply for viewing ticker information. For more information, visit
SOFTBANK MOBILE Corp. Website (http://www.softbank.jp).

® Auto download is not available overseas.

I Registering S! Quick News Items

® Regjister a total of up to five items for Quick and General news and
one item for Special news.

Main Menu P> News/Entertainment P> S! Quick News
p S! Quick News List

Add News = YES

Yahoo! Keitai connects and contents list appears.

2 Select an item
Follow onscreen instructions.
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I Opening New Information

Viewing New Information in Standby
When new information is received, & appears in Standby.

1 InStandby, (B) > 624 to move pointer —» Select
ticker

2 (@)[Select]

Content list appears.

3 Select information
Details appear.

P ececccccccccccccccccooce

ETTD @Show Only Unread Items in Standby @Change Marquee Speed
@Hide S! Quick News @Image Download (C5P.18-19)

Opening S! Quick News List

Main Menu P> News/Entertainment > S! Quick News
P> S! Quick News List

1 Selectan item
Content list appears.

2 Selectinformation
Detailed information appears.

3 To connect to the Network, select a title = YES

I Update Manually
>In Step1, (%7)[Menu] = Update or All Update —> YES

I View Summary
> In Step 1, highlight information =& (x7)[Menu] = Summary Display

M Delete Registered Items
> In Step 1, (highlight information —») [Menu] — Delete or
All Delete = YES (— For All Delete, enter Phone Password)

® Alternatively, Main Menu P> News/Entertainment
p> S! Quick News P> Settings P> Del S! Quick News List

P> YES to delete all information

P ececcccccccccccccccccoe

(ETFD @Automatically Update S! Quick News List @Delete S! Quick
News Information (C%P.18-20)

JUBWIUIRLIBIUT/SMAN | CO
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E-Books (Japanese)

Use Digital Media Viewer, BookSurfing® or e-Book Viewer to
acquire/view e-books, comics, photo books, etc. on handset.
® Digital Media Viewer, BookSurfing® and e-Book Viewer are S! Appli.

@ Download Content Keys (C%P.10-5) to read BMO/CCF/XMDF files.

® Some copy protected files have extensions different from the ones below.

® Launch each viewer via S! Appli, or select a file from Books in Data
Folder.

® When purchasing a new handset, move BMO/CCF/XMDF files via
microSD Card. However, if BMO/CCF/XMDF files are copy protected,
Content Keys backup may be needed (% P.10-24). Some contents
require another Content Key after being moved/copied to a new

® Some PC contents may not be viewable via e-Book Viewer.
Main Menu p News/Entertainment
Digital Media Viewer, BookSurfing or

e-Book Viewer
® See application Help menu for usage information.

Application File Format handset or can not be moved/copied at all.
Digital Media Viewer BMO (.bmo)
BookSurfing® CCF (.ccf)
e-Book Viewer XMDF (.zbf, .zbk, .zbs)




Blogging
Save blog details to update or view blogs.
@ Save up to 20 blog details.

ISaving Blog Details

Main Menu p News/Entertainment > Post Blog
1 (&) [New] = Select an item (See below)

\H

I Posting to Blogs

Main Menu P> News/Entertainment > Post Blog
Post by Mail

Highlight an entry = (@ )[Post] = Compose a
message (C¥ From Step 4 on P.14-4) - (=2)[Send]

Post from Yahoo! Keitai/PC Site Browser

Highlight an entry = (=2)[To site] =

Item Operation/Description

Service name Save a blog service name
> Enter a service name

By Yahoo! Keitai or By PC Site Browser
- YES

Handset connects to the Network and website appears.
Follow onscreen instructions.

I Post Images to Blogs
> While captured image is open, or from Data Folder, select an image
— (¥)[Menu] = Post blog* — Follow Step 1 above

* When Post blog does not appear in sub menu, function is unavailable
(e.g. when sub menu is opened from (&)[Folder] in Picture Viewfinder).

Blogger Save a mail address for posting to a blog by mail
address > Enter a mail address
Mail title Save a title to enter automatically when posting to a blog
by mail
> Enter a title
Yahoo! Keitai Save a URL for posting to a blog from Yahoo! Keitai
URL > Enter a mail address
PC Site Save a URL for posting to a blog from PC Site Browser
Browser > Enter a mail address

® Set Auto save set (C3P.18-17) in Camera menu to OFF to capture

2 (=)[Finish]

and post images directly.

JUBWIUIRLIBIUT/SMAN | CO
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I Blogging Functions

[From Jp Main Menu b News/Entertainment p> Post Blog
I Edit Entries
> Highlight an entry = (@)[Edit] — Edit

M Delete Entries
> Highlight an entry & (x7)[Menu] - Delete —
Select an item (See below)

Item Operation/Description
Delete this > VYES
Delete > Check entries — (=2)[Finish] = YES
selected
Delete all > Enter Phone Password = YES
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Overview

Play music saved on handset/microSD Card.
® Play List: 5 P9-10

Notes

® Files may not play due to file support issues or microSD Card status, etc.
® When playback starts with low battery, confirmation appears.
When battery is low during playback, confirmation appears.
® Playback pauses for incoming calls or Alarm. Playback resumes after calls
are received or Alarm sounds.

Music lllumination

® Notification Light illuminates when playback starts. When playback
starts during charging, Music lllumination lights before Charging
Indicator.

® To turn off light, set Music to OFF in Notification Light setting
(L5 P.18-10).

P ecccccccccccccccccccce
@ Use Bluetooth® Device for Listening to Music (C3P.11-10)

Saving Music

Save Music to play on Music Player.

Open site link to download and save songs

Download =~ f-ct---o-to-olooololololToEhool
Cl?:ll(r::lfta Full® Supported file format: SMC, MPEG-4
(C%P9-3) (MPEG-4 AAC, MPEG-4 AAC+ (HE-AAQ),

Enhanced aacPlus)

Save music CD songs via PC to microSD Card in
AAC format

Supported file formats: MPEG-2 AAC,
MPEG-2 AAC+SBR

Save Music via
SD Audio (C3P.9-3)

Save Windows Media® Audio (WMA) files in PC
to microSD Card via Windows Media® Player

Save WMA files
(C5P9-4)

Supported file formats: WMA

® Some files may not play even if format is supported.

Copy Protected Files

Copy protected files may not play, be saved or forwarded.

To play a copy protected file, obtain Content Key (C%P.10-5).
Confirm file expiry date or usage limitations (Music info: % P.9-8).



Saving Music Files on PCs
When saving music files for use with 942P, observe the following
guidelines:
® Copyrighted Works
- Do not infringe on third party/intellectual property rights.
- Music files are limited to private use.
@ Obtain software to convert file format.
- Refer to websites providing software.
- Performance of some software types is not guaranteed.

I Downloading Chaku-Uta Full®

Access websites directly from Music Player to download
Chaku-Uta Full® files.

® View details (price, expiry date, etc.) on source website.
Main Menu > Data Folder »» Music » Main Folder
Download Music —» YES

Handset connects to the Network and Download site appears.
@ Follow onscreen instructions to download files.

\H

I Saving Music Files by Using SD Audio

Note
® Saving music files requires following:
- 942P
- microSD Card (commercial item)
- USB cable (not included)
- PC (Windows® XP, Windows Vista®)
- Software for PC (commercial item)
Panasonic brand "SD-Jukebox" is recommended. Purchase
SD-Jukebox from website below:
http://club.panasonic.jp/mall/sense/ (Japanese only)
+ Music CD to save

Main Menu P> Settings p> Connectivity »> USB Mode
» microSD Mode

1 Connect handset to a PC via USB cable
Activate SD-Jukebox on PC
Set a music CD on PC

Save music files to micro SD Card

® See SD-Jukebox manual for usage information.
® After saving, release USB cable from handset.

S W IN
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I Transferring WMA Files

Transfer WMA files from PC to microSD Card via Windows

Media® Player. Up to 1000 files can be saved per microSD

Card.

® Use PC with Windows Media® Player installed.

® When using Windows Media® Player 10 (10.00.00.3802 or later)/11 on
Windows® XP, use Windows® XP Service Pack 2 or later.

® \When using Windows Vista®, use Windows Media® Player 11.

@ Insert microSD Card into handset before preparing USB cable
(Transferring Data via USB Cable: C%P.11-17)

Main Menu P> Settings P> Connectivity p> USB Mode
» MTP Mode

1 Connect handset to a PC via USB cable
Follow Windows Media® Player operations to transfer WMA files from
PC to microSD Card.
® Refer to Windows Media® Player Help for operations.
® Terminate all software applications before disconnecting USB cable.

_Note |

® Do not remove microSD Card while transferring files to microSD Card.
Files may be damaged.

® \WMA files overwrite existing files with same name in handset when
copied from PC. To check file names, refer to Windows Media® Player
Help.

® 942P may not recognize WMA files saved to a microSD on a different
handset. Handset may not recognize WMA files from PCs if USB Mode
is set to MTP Mode. Delete WMAudio and WMSystem folders in My
Items (MY FOLDER) on microSD, or format microSD Card (£ P.10-20)
via PC. Formatting microSD deletes all saved files.

® To play WMA files on handset, save files to WMFile (C3P.10-22) on
microSD Card and play the files from PC Movies folder in Data Folder.




Using Music Player

I Playback Window Indicators

Now Playing

Item

Description

File Number/Total Number

Title

Artist

Status

Elapsed Time/Total Time

@S0 0e

Play Mode Indicators

Play only one Repeat one

=] Repeat all Random
Random play&repeat
BEIE DEMO

Equalizer Setting

[N Normal H.BASS1
H.BASS2 Train

© | Stereo/Monaural Stereo DTSN Monaural
| Listening Setting Surround-sound
Natur 1
Natur 2
®| Remaster Setting ON —
@ | Bluetooth® Device —
Connected
®| Volume —
®| Lyric —
®| URL —

9-5
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I Playing Music
1 Press and hold

Player Menu window appears.

® Last playback window appears.
[Menu] = Player menu to show
Player Menu window.

2 Select a category (See below)

Music Player
[HEEALT Tracks ]

E "6enre
——p— p—

Player Menu Window

® Alternatively, play music from Main Menu > Tools p> Music Player

® mp4/3gp files in Ring Songs&Tones folder can also be played in Music
Player.

® Missed Call/New Message Notification Tone ([ P.18-8) is unavailable
during playback while handset closed.

Changing Play Mode

1 Press and hold

Player Menu window or Playback window appears.

Item Operation/Description .
All Tracks Select files from hgndset & microSDpCard 2 [Menu] - Play mode setting
Play List Select group of files saved to Play List 3 Select an item (See below)
Artist Select files from Artist folder
Album Select files from Album folder Item Operation/Description
Genre Select files from Genre folder Normal Play all files in selected category/Play List

® Sk appears for currently/previously played Play List.

3 Select a file
Selected file plays.

® Sk appears for currently/previously played file.

® Playback Window Operations: % P.9-7
® To end playback, (=2)[ ICH]

Play only one Play selected file

Repeat one  Repeat selected file

Repeat all Repeat all files in selected category/Play List
Random Play selected category/Play List files randomly
Random Repeat selected category/Play List files randomly
play&repeat
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Background Music
Listen to music while using other handset functions.

1 While music plays, (€3)[BGM]
2 Toend, in Standby = End player

® Some functions cannot operate simultaneously.
® \/olume or play mode change is not available during Play Background.

Playing Chaku-Uta Full®/WMA Files as Demo

Main Menu P> Data Folder > Music

1 Select an item (See below)

Item Operation/Description
Main Folder  View Chaku-Uta Full® list
> Select a folder
@ To view file list in handset/microSD Card:
(®@)[Phone/microSD]
WMA View WMA list

® ()[Change] to toggle display views in Chaku-Uta Full® and WMA
list.

2 Select a Chaku-Uta Full® or WMA file

Demonstration playback starts.

I Playback Window Operations

Adjust Volume

@ or @i

Play Previous™

) or press and hold [4

® When playback time is over
three seconds, previous file
plays from beginning.

Play Next* (o9 or press and hold [1
Fast-rewind Press and hold (o)
Fast-forward Press and hold (o)
Pause/Resume (o) T/
Stop I = i

View Next Jacket/Lyric

View Previous Jacket/Lyric

Toggle Jacket/Lyric Display
zsﬂﬂlgv\ll’layhst/ﬂayback @ )lList/Player]
Play Background* (@)[BGM]

Toggle Remaster On/Off (C%P.9-8)| (D

Toggl nd Effect (Listenin

Modes (P58)

Toggle Equalizer Modes (L% P.9-8)

* Not available for playback as a demo
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I Functions while Playing Files

I Set Sound Effect
> While playing file, (3z7)[Menu] —> Sound effect — Select an item

M Functions Available in Playback Window
> While playing file, (37)[Menu] — Select an item (See below)

Item Operation/Description

Player menu  Show Player menu

(See below) Play mode  Change play mode (C%P.9-6)
Item Operation/Description setting
Remaster Complement sound from earphone or Bluetooth® device Sound effect (% Left)
to bring close to original sound Music info  Show song title, artist and playback time
> ON or OFF Connect to  Open site link
Listening Add listening effect to sound from earphone or Bluetooth® | \Website > YES
device . Display Image Show jacket
n > Select an item Displav Ivric  Show Ivr
- Surround-sound: Reproduce natural and 15play fyric owyric
= stereophonic sound Previous image/ Show previous jacket or lyric
E - Natur 1 or Natur 2: Complement sound specific to | _Previous lyric
% earphone to reproduce natural sound Next image/  Show next jacket or lyric
o - OFF: Turn off Listening setting Next lyric
E Equalizer Change quality of sound from earphone or Bluetooth®

device
> Select an item
- Normal: Reproduce normal sound
- H. BASS1: Enhance low-pitched sound
- H. BASS2: Enhance low-pitched sound even more
- Train: Minimize sound leakage

9-8




| Chaku-Uta Full®/WMA List

(From Jp Main Menu p> Data Folder > Music

M Confirm Memory Status
> (7)[Menu] - Memory Status

I Functions Available in Chaku-Uta Full® Folder List
> Main Folder — Highlight a folder = (x7)[Menu] = Select an item
(See below)

Item Operation/Description

Add folder > Enter folder name
Edit folder > Enter folder name
name

Delete folder > Enter Phone Password = YES

Memory > Confirm memory status/total files
Status

M Functions Available in Chaku-Uta Full®/WMA File List
> Main Folder or WMA (— Select a folder) = Highlight a file =
[Menu] — Select an item (See below)

Item Operation/Description

Set as ring Set Chaku-Uta Full® as ringtone
tone (Fullsong > Fullsong ring tone — Select an item
ring tone)'

Setasring  Seta segment of Chaku-Uta Full® as ringtone
tone (Point > Point ring tone —» Select a segment — Select an
ring tone)’ item
® To confirm segment: (=8)[Play]
Music info  Show song title, artist and playback time
Move' > Select a storage

Item Operation/Description
Move to Move a Chaku-Uta Full® to microSD Card
microSD'
Add folder' > Enter folder name
Multiple- Select multiple Chaku-Uta Full® files
choice' > Check Chaku-Uta Full® files & [Menu] -
Delete, Move or Send Ir data — Operate selected
item
Connectto  Opensite link
Website' >YES
Display image Show jacket
Memory Memory status/total number of files appears
Status
DEL all Delete all WMA licenses
licenses’ > Enter Phone Password — YES
Delete this > VYES
Delete all Delete all files in folder
> Enter Phone Password = YES
Attach to Attach file to S! Mail/PC Mail (L% From Step 2 on P.14-4)
message'
Send Ir data’ (C%P.11-3)
IC (CFP.11-5)

transmission’

Take contents (C%P.10-5)
key'

! Chaku-Uta Full® files only
2 WMA files only
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I Using Play List

Use Play List to organize Data Folder music files.
Select Music folder files to create Play List links to each file
in its original folder.

Creating New Play Lists

@ Save up to 30 Play Lists with up to 100 songs per list.
® Music files saved on microSD Card are also savable.

1 Pressand hold

Player Menu window or Playback window appears.
® When Playback window appears, (3)[Menu] — Player menu to
show Player Menu window
D Play List > (3)[Menu] -
Create play list — Select a
category and show file list = Check
files to save to Play List =

(&)[Finish]

3 Entera Play List name

LE=AIl SD-Audio tracks
B Gkeitai-001

TBD

Play List Window

® Create WMA Play Lists (using Windows Media® Player) or SD Audio Play
Lists (using SD-Juke Box) on PC. Maximum number of Play Lists to
create and songs to save is as follows:
WMA Play Lists: 100 Play Lists; 250 songs per list
SD Audio Play Lists: 99 Play Lists; 99 songs per list

Playing Songs from Play List

1 Press and hold

Player Menu window or Playback window appears.
® \When Playback window appears, ()[Menu] — Player menu to
show Player Menu window

) Play List = Select a Play List o keRtaiz0D]
05/10-2-5-001
® To play back selected Play List romthe  [Bz10-T5 B
beginning: (&2 [Play] e —
3 Selectafile TDM
Selected file plays back. Play List Contents
Window

® mp4/3gp files in Ring Songs&Tones folder can also be added to Play
List.




I Play List

Press and hold (» ()[Menu] »> Player menu)
P> Play List

I Functions Available in Play List Window
> (Highlight a Play List) [Menu] — Select an item (See below)

\H

I Functions Available in Play List Contents Window
> Select a Play List = (Highlight a file) & (37)[Menu] — Select an item
(See below)

Item Operation/Description

Player menu Open Player menu

Item Operation/Description

Player menu  Open Player menu

Play mode  Change play mode (C%°P.9-6)
setting
Music info  Show song title, artist and playback time

Add Add files to Play List

Play mode  Change play mode (C%°P.9-6) > Select a category, and show contents window —»
setting Check files to add = (=)[Finish]

Create Create a new Play List (C3P.9-10) DEL from Delete files from Play List

play list play list > Select an item —» Operate selected item

Copy play list Copy Play List
> Enter a Play List name

Order to play > Select a file from Play List to change playing order —
&) to change order — (@)[Select]

Edit pl. list  Edit Play List name ® Repeat steps above to change order = [Set]
name > Edit Play List name Add to Add files to another Play List
Add Add files to Play List play list > Add one or Add some (— For Add some, check
> Select a category, and open a Play List = Check files files & (=)[Finish]) = Select a Play List
to add — (=)[Finish] Display image Show jacket
Delete > Select an item —» Operate selected item
play list
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microSD Card Installatio
Format microSD Card....
Viewing microSD Card Files ..
Handset Data Backup....
PC File Transfers
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Variety Photo Viewer.
Viewing Still Images .
Slideshow




Data Folder

Save, play and manage files downloaded from Internet, etc.
® Save still images/videos captured by Camera, downloaded data or data copied/moved from SoftBank handset to microSD Card.

I Data Folder Structure

Folder Function/Saved Data File Format'
Pictures’ Download Pictures Connect to download site JPEG, GIF (.gif including
Variety Photo Viewer Activate Variety Photo Viewer Interlaced GIF),
Main Folder Downloaded still images, etc. GIF Pictogram Package File
Camera Still images captured by Camera, etc. (.gpk), SWF (.swf Flash
My Download My Pict. Connect to download site Animation),
Pictograms | BRICAD Downloaded pictograms, etc. PNG (.png including Interlaced
10 BASLT, RBl, etc. Preinstalled pictograms PNG)
= Mail Art Mail Art (download) Connect to download site
) Pre-installed Preinstalled still images
S Original Animation Display still images continuously
5 Ring DL Ring Songs&Tones Connect to download site SMF. SP-MIDI, AMR, SMAF
‘?" Songs&Tones? | Main Folder Downloaded ring songs/tones, etc. and MPEG-4 formatted files
5 Pre-installed Preinstalled ring songs/tones (:mid, .midi, .amr, .mmf, .3gp,
v Voice Announce Data recorded by Voice Announce .mp4)
Play List Play back Play List
S! Appli? Download S! Appli Connect to download site -
Widget? Download Widget Connect to download site WGT (.wgt), SWGT (.swgt)
Music Main Folder? | Download Music Connect to download site MP4, SMC, WMA (.3gp, .mp4,
Initial Folder Downloaded Chaku-Uta Full® .Smc, .wma)
WMA? WMA Files transferred from PC
10-2
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Folder Function/Saved Data File Format'
Videos? Download Videos Connect to download site MP4 (including .mp4, .3gp,
Main Folder Downloaded video files, etc. SDV), ASF (.asf)
Camera Video files recorded by Camera
Pre-installed Preinstalled video files
BD/DVD Recorder® Videos transferred from HDD Recorder
Play List Play back Play List
Position Memory Play back video files from saved resume position
PC Movies microSD? PC movie files saved from PCs WMA (.wma), WMV (.wmv),
Position Memory Play PC movie files from a saved resume position ASF (asf)
Play History Select a file from playback history
v Image Still images recorded by Digital TV JPEG (jpg)
Video? Programs recorded on handset TOD (.tod), MOI (.moi),
Position Memory Play back video files from saved resume position MAI (.mai), PGI (.pgi)
Lifestyle-Appli| Download Connect to download site (Osaifu-Keitai® C% P.13-9) -

Books? Download Books Connect to download site CCF (.ccf), XMDF (.zbf, .zbk,
.zbs), BMO (.bmo)
Customized | Customized Screen Connect to download site CUSR (.xcsf)
Screen’
Templates Download Templates Connect to download site -
Font Download Font Connect to download site MTF (.mtf)
Main Folder Downloaded fonts
Pre-installed Pre-installed fonts
Other Main Folder Incompatible files attached to mail* -
Documents’

! Some copy protected files have extensions different from above.
2 When microSD Card is installed, press (&)[microSD] in Folder list to view data saved in microSD Card.

3 Available only when microSD Card is inserted.

4 Some attachment files cannot be saved in Other Documents.

s9|14 Buibeuepy 3
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I Operations while Playing Files from Ring Songs&Tones

Opening Files

— . . Stop (@)[Stop]
IVlewmg & Playing Files Volume /R
Attach to messages EI=0

Main Menu P> Data Folder

1 Selecta folder
) [lGi0own load Pictures
® In Folder List, press (&) to toggle handset E@\ral-.r. ) Viewer
=)

folder and microSD Card folder. =l

2 Select a folder = Select a file
- File appears/plays.
=
Q
=
[
=]
=
[Ce)
o
)
wv

® To toggle list/thumbnail view: - :
1212010020510130001
(@)[Change] e

Still Image List
Window

}

When Shortcut to a Download Site is Selected
Handset connects to a download site on Internet.

M Enlarge Still Images
>Main Menu P> Data Folder > Pictures p> Select a folder P> Select

afile > (7)[Menu] > Display size p> Fit in display

10-4



I Copy Protected Files

Playing/forwarding/saving may be restricted and Content

Key may be required for usage.

If Content Key is expired, obtain a new Key to use file.

® U or @ (Silver) appears for copy protected files requiring Content Keys.
L files are accessible. @ files are inaccessible. I8 appears on images
in Thumbnail view of expired files (Original icon appears for Books
folder).

® When deleting T files or folders containing & files, confirmation
appears asking whether to delete corresponding Content Key. Other files
requiring same Content Key may become unusable.

@ See File Properties to confirm restrictions such as expiry term or usage
limitation (Options: C%P.10-6)

® 942P holds up to 1000 Content Keys. Multiple Keys may be required to
use a file.

® Interrupted playback (by incoming calls or Alarm) of copy protected WMA
files with limited usage in Data Folder is also counted as one usage.

Using Copy Protected Files

® Files downloaded on handset cannot be used on PCs.

® Network setting may be required for usage.

® File usage may require insertion of USIM Card in use at time of
download.

® When set as wallpaper or ringtone, settings may return to defaults if
license has expired or different USIM Card is inserted.

® Limited use files cannot be set as wallpaper or ringtone.

Obtaining Content Key
If Content Key is expired, a message appears when the file is opened. To
obtain a new Key, select YES. Handset connects to Content Key site.

® Alternatively, obtain Content Key as follows: Highlight a file =
(x7)[Menu] —» Take contents key — YES

® Depending on contents, some Content Keys may not be obtained from
websites even when warning for expired contents appears.

® When 1000 Content Keys have been saved, a message appears. Delete

old Keys; otherwise downloads may fail (Connection fees apply).

P ececcccccccccccccccccoe
@Back Up Content Key (C%P.10-24)

s9|14 Buibeuepy 3
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I OptiOI'IS Item Operation/Description
Slideshow  Show files in a folder continuously. Select display speed
Highlight a file in Data Folder - (37)[Menu] for the > Normal or Slow
following operations. Delete this  Delete afile
® Some functions may not be available depending on files. > YES
. Delete all Delete all files
M Pictures > Enter Phone Password = YES
Item Operation/Description Multiple- Select multiple files to use
Edit picture  Edit files (C3P.10-11) choice > Check files to use —» [Menu] — Select an item
Display picture Open files Memory Show memory information
Set display*  Set as wallpaper, Phone Book image, Menu Icons, etc. Status
> Select an item Sort Change display order of files
® % appears for item. > Select an order
Picture info  Show file name, file size, etc. Pictures/ Toggle list views
Attachto  Attach files to S! Mail/PC Mail (C% From Step 2 on P.14-4) | File names @ Alternatively, (@)[Change] to toggle
message Take contents Connect to site for Content Key
Graphic mail Add selected files to Graphic Mail (C%P.14-9) key
Post blog Post file on a blog (% P.8-7) * Before setting a file as Video Call related item (except for Incoming/
Send Ir data  Send files via Infrared (C%P.11-3) Outgoing Video Calls), set Select Images to Original (Change Outgoing
IC transmission  Send files via IC transmission (C%P.11-5) Image: C¥P.18-13).
Add shortcut  Create shortcuts (C3P.1-25) To set a file as Menu Icon related item, set Menu Icons to Customize
icon (C5P18-4).
Copy to Copy files to microSD Card ® [f incoming calls arrive or handset is turned off while My Pictograms
microSD package file (.gpk) is being uncompressed, some pictograms in package
Move to Move files to microSD Card file may not open. Retry uncompressing.
microSD

Positioning  Set where to paste files in Standby

> Select a position

Edit file name Edit file names

Move Move files to other folders

P eececcccccccccccccccccoe

@Fnlarge Still Images (C%P.10-4)

@Ctditing Still Images (C3P.10-11)

@Creating Animations (C%P.10-12)

@Saving Still Images to Phone Book (L% P.10-13)

P
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M Ring Songs&Tones M Widget
Item Operation/Description Item Operation/Description

Edit file name Edit file names Paste on (C%P7-2)
Play melody Play back files Stand-by
Setasring > Setas ringtone Widget Show file names, sizes, etc.
tone ® v appears for item. Information
Add shortcut Create shortcuts ((%P.1-25) Attach to Attach files to S! Mail/PC Mail (C% From Step 2 on P.14-4)
icon message
Attach to Attach files to S! Mail/PC Mail (L% From Step 2 on P.14-4) | Send Ir data  Send files via Infrared (C%P.11-3)
message IC Send files via IC transmission (C¥P.11-5)
Send Ir data  Send files via Infrared (L3 P.11-3) transmission
IC Send files via IC transmission (L% P.11-5) Move to Move files to microSD Card
transmission microSD
Copy to Copy files to microSD Card Delete this  Delete a file
microSD >YES
Song-Tone  Show ftitles, file names, etc. Delete all Delete all files
info > Enter Phone Password — YES
Memory Show memory information Multiple- Select multiple files to use
Status choice > Check files to use = (37[Menu] = Select an item
Delete > Select a type

- Delete this — YES

- Delete select = Check files to delete =

(=2)[Finish] - YES

- Delete all — Enter Phone Password — YES

Sort Change display order of files
> Select an order

Move Move files to other folders
Move to Move files to microSD Card
microSD

Take contents Connect to site for Content Key

key

s9|14 Buibeuepy 3
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I S! Appli/Lifestyle-Appli

Item Operation/Description

Start Activate S! Appli or Lifestyle-Appli

Security level Set security level (C%P.16-4)

S! Appli info  Show file names, file sizes, etc.

Add shortcut Create shortcuts (% P.1-25)

icon
Move to Move files to microSD Card
microSD (Lifestyle-Appli cannot be moved)
Delete Delete files
>YES

M Music
® See "Functions Available in Chaku-Uta Full®/WMA File List" (C%P.9-9)
M Videos

Item Operation/Description
Register Set as ringtones, Standby Display or Start-up display
Video info Show titles, file names, etc.
Attach to Attach files to S! Mail/PC Mail (C3 From Step 2 on P.14-4)
message
Post blog Post file on a blog ((%°P.8-7)
Send Ir data  Send files via Infrared (C%P.11-3)

IC transmission Send files via IC transmission (C%P.11-5)

Copy to Copy files to microSD Card
microSD
Move to Move files to microSD Card
microSD
Move Move files to other folders

Item Operation/Description
Add shortcut Create shortcuts (C%P.1-25)
icon
Edit file name Edit file names
Delete this  Delete a file
> YES
Delete all Delete all files
> Enter Phone Password —» YES
Multiple- Select multiple files to use
choice > Check files to use = (x7)[Menu] = Select an item
Memory Show memory information
Status
Sort Change display order of files
> Select an order
Listing Change list view

® (a)[Change] to toggle views

Take contents Connect to site for Content Key
key
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I PC Movies I Books

Item Operation/Description Item Operation/Description
Contents info Show titles, file names, etc. Play Play back files
Move Move files to other folders Connectto  Opensite link
Copy Copy files to other folders Website
Multiple- Select multiple files to use Book info Show file names, file sizes, etc.
choice > Check files to use = (x7)[Menu] = Select an item Copy to Copy files to microSD Card
Comment Show descriptions microSD
view Move to Move files to microSD Card

microSD

Memory Status Show memory information

Delete this  Delete a file

Add folder  Add folders

> YES Edit file name Edit file names
Delete all Delete all files Move Move files to other folders
> Enter Phone Password —» YES Take contents Connect to site for Content Key
WV key
® See Pictures folder for still images. Delete Delete fles
>YES
Item Operation/Description
Edit title > Enter titles
Video info Show titles, channel names, etc.
Add shortcut Create shortcuts (C%P.1-25)
icon
Delete > Select an item

- Delete this — YES
- Delete selected = Check files to delete =&
(=)[Finish] - YES

- Delete all = Enter Phone Password — YES

Memory Status Show memory information

Listing Change list view
® (a)[Change] to toggle views

s9|14 Buibeuepy 3
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M Customized Screen M Templates
Item Operation/Description Item Operation/Description
Preview Preview files Compose Send files via S! Mail (C3P.14-5)
Collective Set Customized Screen all at once S! Mail
Setting Edit title Edit titles
File info Show titles, file names, etc. Template info Show title and file size
Copy to Copy files to microSD Card Delete this > YES
it . - Delete > Check files to delete = (=)[Finish] - YES
Move to Move files to microSD Card
5 selected
ml.cro.SD — Delete All > Enter Phone Password —» YES
Edit file name Edit file names
Delete this  Delete a file M Font
10 > YES Item Operation/Description
Delete all Delete all files Set Aoply selected font
§ > Enter Phone Password = YES — PRy : A
S Multiple- Select multiple files to use F|I.e ujfo Shgw. file names, file sizes, etc.
@ choice > Check files to use = (37)[Menu] — Select an item Edit title Edit titles
a3 Memory Show memory information Delete this  Delete a file
s} Status >YES
] Sort Change display order of files Delete all Delete all files
> Select an order > Enter Phone Password = YES
Listing Change list view Multiple- Select multiple files to use
@ (a)[Change] to toggle views choice > Check files to use = (7)[Menu] = Select an item
Take contents Connect to site for Content Key Memory Show memory information
key Status
Connectto  Open site link Sort Change display order of files
Website > Select an order
Listing Change list view
@ ()[Change] to toggle views
10-10
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Using/Editing Still Images

Item Operation/Description
File info Show file names, file sizes, etc. I Edltlng Still Images
- e -
Attach to Attach files to S! Mail/PC Mail (C% From Step 2 on @ Edit features are not available for all ile types.
message P.14-4)
Copy to Copy files to microSD Card Main Menu P> Data Folder p> Pictures
microSD ;
Edit file name _Edit file names Select a folder = Select a file = (37)[Menu] —»
Move Move files to other folders Edit picture
Delete this Delete a file )
> YES 2 (x7)[Menu] — Select an item (See below)
Delete all Delete all files . —
> Enter Phone Password = YES Item Operation/Description 10
Multiple- Select multiple files to use Marker stamp > Selectg stamp = 684 to move stamp "._E].[Pllt]
choice > Check files to use = (7)[Menu] = Select an item ® following options are available when positioning a §
Memor Show memory information stamp: 3
Status U " fymiormet - To rotate or scale up/down: (x)[Menu] - é_
Sort Change display order of files Select an item &
>5 |g t P yd - To start over: [Cancel] -
cect an order ® To add: ()[Add] 3
Frame > Select a frame
® Titles of mp4/3gp Ring Songs&Tones files and Videos/Music/Customized ~ Torotate 180 degrees: (x7)[Menu] -
Screen files appear in respective lists. Files without titles appear with 180° rotation
file names (created when files are saved to handset). Titles cannot be - To change frame: @
changed; edited file names may not appear in lists. - To return to frame lst: (&)[Cancel]
Character > Enter text —» (34 to move text = (@)[Put]
stamp @ To change content/color/font/size: When positioning
stamp, (7)[Menu] — Operate selected item
@ To start over: (&)[Cancel] after positioning
W/ Next Page __AERTIREI



Item

Operation/Description

Fit in screen

Change image size to Standby (480 x 854)
>YES

Change size

> Select a size
® To start over: (=)[Cancel]

Trim away > Specify a size = 684 to specify area = (@)[Set]
® To start over: After specifying area, (=)[Cancel]
Retouch > Select an item
® To start over: [Cancel]
Rotate > 90° to right, 90° to left or 180°
® To start over: (=)[Cancel]
Brightness > (9 to adjust brightness
10 Attach to Attach edited file to S! Mail/PC Mail
= message'? > (@)[Set] = Compose message (L3 From Step 2 on
P.14-4)
)
2 ® Alternatively, [m] to attach image to a
Qe message
3 Post blog'>  Post on a blog
] > (@)[Set] - Post on a blog(C%*P.8-7)
Q Save' Overwrite/rename to save edited files
! Available after other editing operations.
2 File is automatically saved.
3 (eJiset] > (e)isave]
4 YES (Overwrite) or MO (Save as)
10-12
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I Creating Animations

Saving Original Animation

Main Menu P> Data Folder p> Pictures > Original Animation

1 <New> = <1st> - <20th>

2 Select a folder = Select a file
® Repeat Step 2.

3 (&)[Finish]
Functions Available in Original Animation List

In Original Animation list, press (¥7)[Menu] for following
operations.

Item Operation/Description

Edit title > Enter title

Org. animation Add more files to an Original Animation (3 Above)

Display Play back an Original Animation

picture ® Alternatively, select an Original Animation from list to
play back.

Set display Set an Original Animation as Standby display, etc.

> Select item to set Original Animation as

Picture info  View item set for Set display

Release
animation

Cancel a saved Original Animation
>YES




}
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ISaving Still Images to Phone Book

® Savable sizes:
- Standby (480 x 854) or smaller in JPEG or GIF format (up to 300 Kbytes)
- VGA (640 x 480) or smaller in PNG format

® Save images to up to 100 Phone Book entries.

@ Still images cannot be saved to USIM Card Phone Book entries.

Main Menu P> Data Folder P> Pictures

Select a folder = Select a file = (¥7)[Menu] =
Set display — Phone Book

New Entry
New — Enter details (= From Step 2 on P.4-3) =&

(=2)[Finish]
Add to Existing Entry
Add —» Select entry & (=)[Finish] - YES

Playing Videos
I Playing Videos/PC Movies

Main Menu P> Data Folder

Play Videos

Videos — Select a folder = Select a file

Play PC Movies

PC Movies - microSD —» Select a file
® To toggle file list views: (ca)[Change]

I Playback Operations 10
@ Some operations are not available depending on files.
® Operation descriptions are based on Normal Position. §
- =
Adjust Volume @) or WM &
é.
Play Previous @ Starts from beginning when playback time is -
over three seconds. 5
w
Play Next E)
Fast-rewind’ Press and hold (0)
Fast-forward' Press and hold (o)
Playback Position? | (o) repeatedly
Change Speed (=[O /)
Mute/Resume 2 = 0 o
Pause/Resume Qt n [ > |
Play Frame by While pausing, (=2)[Frame]
Frame' ® Play back frame by frame
10-13
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@

® Toggle: Portrait View —» Landscape View (fit
to Display size) = Full-size Landscape View?

Toggle Views

Toggle Remaster
on/off ((rpog) |

\H

M Functions Available in Video Window
® Some functions may be unavailable depending on the file type.
@ QOperation descriptions are based on Portrait View.

Adjust Volume

@ or HF

Toggle Sound Effect
(Listening) Modes
(C5P9-8)

Toggle Equalizer

Modes (C5P.9-8)

Play Previous

©

® \When three seconds into the chapter,

! Videos only
? May be unavailable depending on image size.

I Playing Videos Recorded on HDD Recorder

Transfer programs recorded on HDD recorder to microSD

Card via USB cable (not included) for playback on handset.

® Set USB Mode to microSD Mode before connecting handset to HDD
recorder (C3P.11-17).

® For details about transferring videos, see HDD recorder manuals.

® Use Earphone Microphone for stereo sound. Use a Bluetooth® device for
wireless audio output (C%P.11-10).

Main Menu P> Data Folder P> Videos > BD/DVD Recorder
1 Select a file

10-14

Chapter playback returns to beginning of current
chapter.

Play Next Chapter | (o)

. While playing/pausing, press and hold (9
A4 (eeere) @ Skip about 30 seconds forward.

. . While playing/pausing, press and hold ()
Sl el @ Skip about 10 seconds backward.

® To play back: (o[ HEH]

Fast-rewind ® Play back at normal speed during 10x

fast-forward. Play back at 10x speed during
30x fast-forward.

Fast-forward

® To play back: (o[ HCE]

® Play back at normal speed during 10x
fast-rewind. Play back at 10x speed during
30x fast-rewind.

Playback Position

(99 repeatedly

Change Speed (@) IEN/EE /|
Mute/Resume o) IEE/ T |
Pause/Resume (o) [/ I |

Play Frame by
Frame

While pausing, (=2)[Frame]
® Play back frame by frame




@)
® Toggle: Portrait View —» Landscape View (fit
to Display size) = Full-size Landscape View

Toggle Views

Toggle Remaster

\H

M Functions Available in Video/PC Movie Playback Window
@ Some operations are not available depending on files.
> While playback is paused, [Menu] — Select an item (See below)

on/off (c¥p9-8) |
Toggle Sound Effect
(Listening) Modes
(C¥P9-8)

Toggle Equalizer

Modes (C5P.9-8)

I File Playback Functions

I Play Back from a Resume Position

Resume playback (videos/PC Movies) from a saved position.

>Main Menu P Data Folder > Videos or PC Movies
> Position Memory P> Select an item

® Save a resume position: [ Right

® Marker to resume is a resume position automatically saved when a
call arrives, alarm goes off, battery runs low, or playback is terminated.

I Play Back from Play History (PC Movies Only)
>Main Menu p> Data folder > PC Movies p> Play History
P Select a record

Item Operation/Description

Normal play' Play at normal speed
Slow' Play at slow speed
Quick View  Play 1.25 times faster than normal
(1.25x)'
Quick Play at double speed
View(2x)'
Fast? Forward
Rewind? Rewind
Stop Return to Videos/PC Movies List window 1 0
Position to  Start playback from specified point =
play > (o) to highlight a play point = (@)[Set] 2

o ]
Connectto  Qpen site link =3
Website' > YES @
Sound effect Remaster, Listening or Equalizer (C P.9-8) s}
Contents info?  Show title, file name, etc. 2
Position Save resume position
memory > Select a resume position

® To play back from a saved position: [ Left
Mail/blog' Attach file to a message to send or post on a blog
> Select an item
- Attach to message (5 From Step 2 on P.14-4)
- Post blog (% Step 1 on P.8-7)
10-15
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Item Operation/Description

Register Set as ringtone

\H

Managing Folders/Files

(Ringtones)' > Ringtones —» Select a type I Managing Folders

® % appears for item set as ringtone.
Register Save a file as Standby Display or Start-up Window The following operations are available in Pictures, Music,
(Stand-by > Select an item = YES Books, Videos, Ring Songs&Tones and Other Documents.
Display/Start-up )
Window)' Main Menu P> Data Folder
Video info'  Show title, file name, etc. .

: : Select a folder = (¥7)[Menu] — Select an item

Send Ir data’ Send file via Infrared (C%P.11-3) bel [ ]
IC transmission' Send file via IC transmission (L3 P.11-5) (See below)
Add shortcut Create a shortcut (C%P.1-25) Item Operation/Description
icon' Add folder  Create user folders

1 0 Description’  Show file informa_tion o ) Edit folder Edit user folder names
= > The words view or Description view name
% C?PV UR':Z Copy URL_ : Delete folder Delete a user folder
Qe Display size  Select a dlsp!ay size > Enter Phone Password —» YES — YES
3 > Actual size or Fit in display Folder Hide files in folder unless Phone Password is entered
- Change to Toggle: Portrait View = Landscape View (fit to Display security’ > Enter Phone Password = YES
o full’ size) = Full-size Landscape View? {3 appears for folder.
® To toggle views: (1) ® To cancel: Repeat the step
" Video files only Delete all > Enter Phone Password = YES — YES
2 PC movie files only image’ : :
3 May be unavailable depending on image size. Eﬁllt3 Play Edit Play Lists
List
Release Play Cancel edited Play Lists
List® >YES
10-16
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I Using Play List

Use Play List to organize Data Folder Ring Songs&Tones/
Videos files.

Item Operation/Description
Select Specify folders on microSD Card to save files to
storage* >YES
® Folders cannot be specified when saving Books files.
Memory View memory capacity/number of saved files
Status®

Select Ring Songs&Tones, Music or Videos folder files to
create Play List links to each file in its original folder.

! Pictures/Videos folders only

2 Pictures folder only

3 Play List folder in Ring Songs&Tones folder only
* microSD Card only

> Music folder only

Creating Ring Songs&Tones Play Lists

Main Menu P> Data Folder »> Ring Songs&Tones
1 Highlight Play List = (7)[Menu] — Edlit Play List

2 Select a number = Select a folder —» Select a file 10
® R t Step 2.
epeat Step §
3 (=[Finish] 3
Q,
I Play Back Play List 3
>Main Menu P> Data Folder p> Ring Songs&Tones p> Play List ny]
® Files are played back in the saved order. a
I Delete a File
> After Step 1, select a file — Release this
M Delete All Files
>1In Step 1, (%7)[Menu] = Release Play List—> YES
® mp4/3gp files cannot be added to Play List except in Music Player Play
List.
10-17
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Creating Video Play Lists

Main Menu P> Data Folder > Videos »> Play List
1 Select a Play List

2 Select a number = Select a folder = Select a file
® Repeat Step 2.

3 (=)[Finish]

I Play Back Play Lists
>Main Menu P> Data Folder > Videos P> Play List »> Highlight a
Play List - (=2)[Play]

® Files are played back in the saved order.

I Delete Files
> After Step 1, (highlight a file =) (7)[Menu] = Delete this or
DEL all from list > YES

I Change Order
> After Step 1, (z)[Menu] = Oder to play — Select a file = Select a

target = (=2)[Finish] = (=)[Finish]

10-18
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microSD Card

® 942P is compatible with up to 2 GB commercial microSD Cards and up
to 16 GB commercial microSDHC Cards (as of December 2009).
For information on memory card compatibility, visit the website
below (Japanese). Note that microSD Cards not listed on the website
may not function properly.
- From Yahoo! Keitai
P-eqgg (as of December 2009)
Main Menu P> Yahoo! P> Bookmarks
p> Panasonic Site (P-egg)
+ From PC
http://panasonic.jp/mobile/
Not all operations are guaranteed by the microSD/microSDHC Cards
listed.
@ Format new microSD/microSDHC Cards for use with handset

(C5P.10-20).

® SoftBank is not liable for damages from accidental loss/alteration of
microSD Card information. Keep a copy of Phone Book entries, etc. in a
separate place.

® microSD Card has no write protect feature; there is a risk of accidental
erasure/overwriting of files.




I microSD Card Installation

® Turn off handset before inserting/removing microSD Card.
® Battery Installation: L% P.1-15

Inserting

1 Insert microSD Card until it clicks

microSD Card Check

When microSD Card is installed correctly, B appears. If E',"I appears,
microSD Card cannot be used. Remove microSD Card from handset, and
re-insert it. If E',"l does not disappear, execute Check microSD (L5 P.10-23)
or format microSD Card (C%P.10-20).

(Display Indicator: C%P.1-10)

\H

Removing

Push microSD Card in
® microSD Card pops out with a light push.

® Do not turn off handset or remove battery/microSD Card while E3
flashes. microSD Card may be damaged or files lost.
® microSD Card may pop out when inserting/removing it.

s9|14 Buibeuepy 3
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I Format microSD Card
® Formatting microSD Card deletes all saved files/data.

Main Menu P> Tools > microSD Backup
1 ([Menu] > microsD format

2 Enter Phone Password = YES

1 Selecta category

® Do not turn handset power off or remove microSD Card or battery while
formatting; may damage handset or microSD Card.

® microSD Cards formatted on other devices may not be used. Format
microSD Card on 942P before use.

® Handset cannot format incompatible microSD Cards.

@ |f format fails, turn power off and remove microSD Card from handset.
Reinsert microSD Card and format it again.

2 Select a file

3 Select a data

IViewing microSD Card Files

View Phone Book entries, Calendar events, Tasks, mail
messages, Notepads and Bookmarks backed up on microSD
Card.

Main Menu P> Tools P> microSD Backup

10-20

microSD Backup

Category List

Phone Book
|1[=10020500 |

TBD

File List

Data List

Backup date appears as file name.

?6“55:‘3'3“

Detailed Data

® |f messages on microSD Card do not appear correctly, copy messages to
handset (C%P.10-21) and execute Charset Conversion (CFP.14-23).




I Handset Data Backup

Back up handset data (Phone Book, Calendar, Tasks, Messages,
Notepad, Bookmarks, Content Keys) to microSD Card; restore
handset data after accidental loss/alteration.

@ Back up Content Key: C¥P.10-24

Backing up to microSD Card

Main Menu P> Tools > microSD Backup

1 Highlight a category = (x7)[Menu] -
Copy to microSD (— For Bookmarks, select an
item)

7 Enter Phone Password = YES
Al files of selected category are backed up to microSD Card.

M One File Backup
> Open a file = (x7)[Menu] = Copy to microSD — YES

Restoring from microSD Card

Main Menu P> Tools > microSD Backup

1 Select a category

Restore One Item
Select a file = Highlight an item = (3)[Menu] —
Add to phone

Restore One File
Highlight a file & (¥7)[Menu] = Add to phone or
Overwrite to phone — Enter Phone Password

Restore All Files

(x7)[Menu] = Add all to phone or
Overwr. all to ph. = Enter Phone Password

3 YES 10
=
_Note | ]
® Note that Overwrite to phone or Overwr. all to ph. erases all files S
of same category on handset. é
® Video files of 100 MB or larger cannot be moved from microSD to -
handset. 5
® Files of 10 MB or larger except for Videos/Books files (BMO files) v
cannot be moved/copied from microSD to handset.
® Data backed up in other SoftBank handsets may not be restored in
942P depending on type and size.
P eececcccccccccccccccccoe
@Delete Items from microSD Card @View microSD Card Memory Capacity
(C3P.10-23)
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I PC File Transfers

Folder Structure

Files moved or copied from handset to microSD Card are
organized as follows:
® Save files in folders by file type.

Games and More S Appli
Music Sound files with .3gp, .mp4, .smc
Other Documents Other files
Pictograms My Pictograms

Still images moved/copied from
Pictures handset to Main Folder in microSD

Card

Sound files of:
up to 10 MB with .3gp, .mp4,

Sounds & Ringtones up to 300 KB with .mid, .midi,

.amr
Videos moved/copied from
Videos handset to Main Folder in microSD
Card
Widget Widget contents
) PC movie files saved from PC to
VMFile® microSD Card
SD_VIDEO

® Videos saved to microSD Card

@ Videos recorded from Digital TV or transferred from HDD recorder.

® Some copy protected files have extensions different from above.
® When moving/copying videos from microSD Card to handset, file format
or file size may change.
* If WMFile does not appear in My Items (MYFOLDER), create and save a
folder titled WMFile.

DCIM
® Still images saved to microSD Card
PRIVATE
MYFOLDER
Utility
Calendar Calendar.BCK Calendar Backup files
Contacts Contacts.BCK Phone Book Backup files
Rights Content Key Backup files
Tasks Tasks.BCK Tasks Backup files
Memo Memo.BCK Notepad Backup files
Mail
Drafts Drafts.BCK Drafts Backup files
Inbox Inbox.BCK Incoming Mail Backup files
Outbox Outbox.BCK Unsent Messages Backup files
IS\Aegjsages ;eCnKt Messages. Sent Messages Backup files
My Items
Book E-comics, etc.
Bookmarks \ Bookmarks.BCK | Bookmarks Backup files
Flash(R) Flash® files
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Using Data on microSD Card

With a microSD Card inserted, connect handset with a PC
via USB cable (not included) to read/write data from/onto
microSD Card.

Following equipment is required:

® Connector Cable: USB cable

® PC: PC with USB port (Universal Serial Bus Specification Rev 1.1/2.0
compliant)

® Compatible Operating Systems: Windows® XP, Windows Vista® (Japanese
version in each)

Main Menu P> Settings »> Connectivity > USB Mode

» microSD Mode

1 Connect handset to PC via USB cable while handset is
on

® PC recognizes microSD Card.
° @ appears in Standby (handset).

® Even if incoming call arrives, reading/writing data continues during
calls. After calls, check indicators on PC to see if reading/writing is
complete.

® File names saved in microSD Card may not properly appear if changed
on PC.

\H

I microSD Card Functions

I Restore microSD Card items (Check microSD)

Use Check microSD to repair microSD Card data errors.

> Main Menu P> Tools P> microSD Backup P> (37)[Menu]
» Check microSD P> YES

® Do not turn handset power off or remove microSD Card or battery while
formatting; may damage handset or microSD Card.

® |t may take 30 seconds or longer to complete Check microSD depending
on data volume on microSD Card.

® Handset cannot check incompatible or unformatted microSD Cards.

® Handset may delete files and folders that fail to be restored.

I Delete Items from microSD Card

>Main Menu P> Tools > microSD Backup P> Select a category
P (Highlight a file =) (37)[Menu] > Delete this or Delete all
(p> For Delete all, enter Phone Password) »> YES

® Content Key cannot be deleted.

M View microSD Card Memory Capacity
> Main Menu P> Tools P> microSD Backup P> (37)[Menu]
» microSD info

s9|14 Buibeuepy 8
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I Back Up Content Key

Copy Content Keys to microSD Card from handset or to handset from

microSD Card.

>Main Menu P> Settings P> Security P> Content Key
»> Copy to microSD or Copy from microSD P> Enter Phone
Password

@ Content Keys with expiration dates or usage limits cannot be backed up.

® USIM Card inserted when Content Keys were moved to microSD Card
must be inserted to move Content Keys from microSD Card.

® Some applications are not compatible with handset. Only Content Keys
for compatible applications are backed up. Also, note that some keys are
moved to microSD Card when backed up. Contact SoftBank Mobile
Customer Center, General Information for more information

10 (C%P.19-34).
= ® Backing up Content Keys overwrites previously saved Content Key
) backup.

]

]

Q
]

Q@

I
o
w
10-24

\H

Variety Photo Viewer

View still images in Pictures folder (Data Folder) using
Variety Photo Viewer. Slideshow is also available.

® Variety Photo Viewer is available in Horizontal Open Position only.
® Only JPEG files are supported by Variety Photo Viewer.

I Viewing Still Images
Main Menu P> Data Folder P> Pictures

1 Variety Photo Viewer

Folder list appears.

Folder List

Select a folder
File list appears.

File List




3 Select a file Available Operations
File image appears. M From Folder/List Window
In folder/file list window, press (&)[FUNC] for following operations. Follow
onscreen instructions.
Item Operation/Description
Slideshow  Start slideshow (C%P.10-26)
Image Window Kisekae* Change theme for folder list
® To zoom in/out: (@)[Zoom]/[Return] * Folder list window only
e A o ettt 567 | o mag Window
9 P 9 In Image Window, press (@a)[FUNC] for following operations. Follow
M Operation Guide onscreen instructions.
> (¥)[Guide] Item Operation/Description 10
I Toggle Icons On/Off Slideshow  Start slideshow (C%P.10-26) =
> (@)[lcon] Zoom Enlarge to 200% 8
Rotate Each press rotates image 90° clockwise S
® Copy protected files are not viewable. é\lttnzjlcl.ilto Send file via S! Mail (£ From Step 2 on P.14-4) 3
@ Connect handset to a TV (3 P.11-18) and view images using Variety : Ml - =
Photo Viewer. Post blog Post file to a blog (L3 P.8-7) o
Effect Set slideshow effects
Delete Delete file
® Some files may not appear right side up when posted to a blog.
I Face Zoom
Face Zoom is available when a face is detected.
> In Image Window, (=)[FaceZoom]
® When more than one face is detected, each press zooms in on another
face.
10-25
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Touchpad Operations I Slideshow

Use Touchpad operations in Variety Photo Viewer.
® Touchpad: C¥P.1-23

View files in succession.
Main Menu P> Data Folder > Pictures

M Scroll Page/Screen ) Variety Photo Viewer
® Slide left/right to scroll files in File List.
® Slide left/right to scroll images in Image Window. 1 View All Images
() [FUNC] = Slideshow

View Selected Folder

Select a folder — (&a)[FUNC] = Slideshow

Slideshow starts.

@ Press and hold (2) in Standby from Horizontal Open Position to show
files in all folders.

M Zoom
Slide up/down to zoom in/out from Image Window.

=
o
S
D
Q
S
@
I
o
w
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Slideshow Operations

Press (@) during slideshow to pause and open menu. Follow
onscreen instructions.

I Change Slideshow Settings
Pause slideshow and select Settings. Follow onscreen instructions.

Item Operation/Description
Time Set slide display time
Effect Set transition effects
Face zoom Zoom in on faces
Random Shuffle files
Repeat Repeat slideshow

® Face zoom may be unavailable depending on file type.

s9|14 Buibeuepy 3
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Infrared
I Before Using Infrared

Transfer Phone Book/Calendar events, messages, bookmarks

and Data Folder files wirelessly between handset and

compatible devices, including PCs and other mobiles.

® 942P infrared function is based on IrMC1.1, however, some IrMC1.1-
based device transmissions may not be transmitted/received within
specification.

® Debris may inhibit infrared transfers; clean infrared ports with a soft cloth
beforehand.

® Direct sunlight/fluorescent light may inhibit transfers.

® Align infrared ports within 20 cm of one another and make sure no
objects are placed between them. Do not move the devices until transfer
is complete.

Infrared Port

Transferable Files

Condition - .
Transferable file il bl
Phone Book (Account Details) O Up to 1000
Calendar events' O Up to 1000
Tasks O Up to 100
Received message O Up to 3000
Sent message O Up to 1000
Drafts O Upto 10
Notepad O Up to 20
Ring Songs&Tones O —
Still image?? O —
Video’ O —
Bookmark
(Yahoo! Keitai, PC Site Browser) O Up to 100 each
Widget® O —

O: Transferable —: Not transferable

! Saved Holidays/Memorial days not transferable
2 Including Flash® files

3 Multiple files transferable

® Following files cannot transfer:
- Files prohibited for transfers from 942P
- Phone Book entries and SMS on USIM Card
® |f memory becomes full, remaining entries are truncated (Memory List:

C$P.19-25).




I One/Multiple File Transfer
® Transferable Files: C%P.11-2

Sending
1 Highlight a file, and follow the steps below

Files to Send Operation/Description

Phone Book > (x7)[Menu] = Send Ir data — Send phonebook

Account > (@)[Ir]
Details
Messages > (@)[Menu] - Send Ir data — Send This
Bookmarks > (x/[Menu] - Send to ExtrnlDvcs -
Send Ir data — Send This
still Images/ > (x7)[Menu] - Send Ir data
Videos/ ® To send multiple files: [Menu] d
Widgets Multiple-choice — Select files to send
(¥7)[Menu] - Send Ir data
Other Files > (¥7)[Menu] — Send Ir data
2 YES
Receiving

Main Menu P> Tools P> Receive via Infrared » Receive

When a file is received, YES

Send files from sender side within 30 seconds.
® To receive subsequent files, select YES.

\H

I All File Transfers

Precaution

® Receiving all files overwrites all saved files including secret/protected
files.

@ Sending all Phone Book entries transfers Account Details as well.
User-saved Account Details is overwritten on receiving handset
(handset number remains).

Session Number

Session number (4 digits) is required for all file transfers via Infrared and
IC transmission. Sender and recipient must enter same Session number to
complete transfers.

Sending
1 Highlight a file, and follow the steps below

Files to Send Operation/Description

Phone Book [Menu] — Send Ir data — Send all phonebook

Messages (x7)[Menu] = Send Ir data — Send All

Bookmarks  (x7)[Menu] = Send to ExtrnIDvcs — Send Ir data
—> Send All

Other Files  (wJ[Menu] = Send all Ir data

2 Enter Phone Password —=» Enter Session number =
YES

Recipient must enter the same Session number to start transfers.

11-3



Receiving
Main Menu P> Tools P> Receive via Infrared »> Receive All

Enter Phone Password —» Enter same Session number
as sender's —» YES = YES

Saved files are deleted, and transfer starts.

11-4
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IC Transmission

Exchange files with another IC compatible handset using

reader/writer function.

® Type of files and transfer conditions are same as those for infrared file
transfer (C¥P.11-2).
Multiple file transfer is not available.

® |C transmission is not available when /C Card Lock (C%P.13-12) is
activated.

® When receiving dada, end all active functions.

@ If there is difficulty in file transfer, move a %) logo close to or away from
the other logo or move each side up, down, left, or right.

@ Data cannot be sent during charging battery.

Q
|
i‘l’ Align 5) logos of both handsets



I One File Transfer

Before Receiving a File

® Receive IC Datum is set to ON by default. When
Receive IC Datum is OFF, One File Transfer is unavailable.

® To set Receive IC Datum on:

Main Menu P Tools or S! Appli P> Osaifu-Keitai

P> IC Card Settings »> Receive IC Datum »> ON or OFF

Sending
1 Highlight a file, and follow the steps below

\H

I All File Transfers

® Precautions/Session number ([ P.11-3)

Sending

1 Highlight a file, and follow the steps below

Files to Send Operation/Description

Phone Book > (¥7)[Menu] = /C transmission —

Files to Send Operation/Description
Phone Book > (¥7)[Menu] — /C transmission —
Send all phonebook
Messages > [Menu] = IC Transmission —» Send All
Bookmarks > (¥7)[Menu] = Send to ExtrnlDvcs —
IC transmission — Send All
Other Files > [Menu] = AllIC transmission

Send phonebook
Account > (@)[ICtrans]
Details
Messages > (¥7)[Menu] - IC Transmission — Send This
Bookmarks > [Menu] — Send to ExtrnlDvcs =
IC transmission — Send This
Other Files > (3)[Menu] = IC transmission
2 YES
Receiving

1 Align £2) logo on sender side with 942P (recipient) —

YES

2 Enter Phone Password = Enter Session number —

YES

Recipient must enter the same Session number to start transfers.

Receiving
1 Align 2] logo on sender side with 942P (recipient)

2 YES — Enter Phone Password = Enter same Session

number as sender's
Saved files are deleted. Transfer starts.

0 E
=)
S
=
o
[a]
=
s
=3
<

11-5



my

0
=)
S
=
o
[a]
=4
s
=3
<

11-6

Bluetooth®

Connect handset to Bluetooth® devices to use functions

\H

below.
Function Device Description
Handsfree Calls Headsets
(CFP11-10) Handsfree devices Talk handsfree on handset

Wireless Playback

Audio devices

Play back sounds (Digital TV/
Video) or music (Music Player)

I Before Using Bluetooth®

Bluetooth® Specifications

Version

Bluetooth® specification Ver.2.0+EDR

Supported Profiles'

HSP: Headset Profile

HFP: Hands-Free Profile

A2DP: Advanced Audio Distribution
Profile

P ececcccccccccccccccccoce

@D @Stop Ringtone Output to Headset/Handsfree Device
@ Continue Calls on Handset when Bluetooth® is Disconnected
from Headset/Handsfree Device @Always Make Calls from
Handset even when Headset is Connected @Always Use
Handsfree Device to Make/Receive Calls (C3P.18-20)

(C%P.11-10) wirelessly from external AVRCP: Audio/Video Remote Control
speaker Profile

Internet DUNP: Dial-up Networking Profile
Connection PC Use handset as a modem for OPP: Object Push Profile
(C%P.11-10) wireless internet connection. Output Bluetooth® Power Class2

- — > -
e PO P T — e
(CP11.9) Handsets entries wirelessly PP i

! Bluetooth® connections are available with compatible devices supporting

the same profile.

2 Bluetooth® operates in the 2.4 GHz unlicensed frequency band. Depending
on other devices in use in the spectrum, Bluetooth® connection may slow
down/terminate, or range may decrease.

3 Affected by distance between devices, obstructions, signal conditions,

handset status, etc.



Notes

® Bluetooth® connection is not guaranteed with all Bluetooth® devices.

® Establish connections with certified Bluetooth® devices that meet the
specification standards developed by Bluetooth® SIG.

® Due to the unique characteristics/specifications of a certified Bluetooth®
device, connections or transfers may fail; procedures, displayed results or
operations may vary from those described in the manual.

® When data transfer is interrupted, it may take some time for process to
complete.

® Noise may interfere with wireless or handsfree conversations depending
on the status of connected devices or signal conditions.

@ For details about headset/handsfree devices, see the device manuals.

@ Bluetooth® and Wi-Fi are not simultaneously available.

Radio Wave Interference with Wi-Fi Devices

Bluetooth® and Wi-Fi devices (IEEE802.11b/g) share the same frequency

band (2.4GHz). Use of both devices in close proximity may cause

interference, affecting transmission speed, clarity or connection quality. If

interference occurs:

® Maintain at least 10 m between Bluetooth® and Wi-Fi devices.

® Turn off Wi-Fi device when using Bluetooth® device withina 10 m
radius.

\H

I Using Bluetooth®

Pair Bluetooth® devices with handset beforehand to
establish connections for different Bluetooth® functions.

Searching & Pairing Devices

Search other Bluetooth® devices.

Paired devices appear in Search&Paired Device list.

@ Bluetooth® Passkey is not necessary for paired devices.

@ Search up to 20 Bluetooth® devices at one time; pair with up to ten
Bluetooth® devices.

® Place Bluetooth® devices on standby for connection.

Main Menu p> Tools P> Bluetooth P> Search&Paired Device
1 YES*

Device search starts and names of found devices appear.

® To search again: (=)[Search]

*If there are already paired devices in list, select a device = Select a
function

2 Select a device = YES — Enter Phone Password

Select text entry field = Enter Bluetooth® Passkey

w

4 Select a Bluetooth® function

V/ __Next Page 4
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Handset connects to Bluetooth® device. When complete, €3 flashes in

blue. After no Bluetooth® connection is made for a certain time,

€3 appears in black and Power saver mode starts.

® When Bluetooth® device can connect to multiple services,
confirmation appears asking whether to connect to another service.

® While connected, [% (Blue) appears. While in Standby, [ (Gray)
appears.

® \When Dial-up is selected, handset stands by for connection
requests from other Bluetooth® devices.

® Dijal-up can be selected regardless of profile types.

Bluetooth® Passkey

Bluetooth® Passkey (1 to 16 digits) is required to connect

Bluetooth® devices; sender and recipient must input the same code to
complete file transfers.

@ Bluetooth® Passkey is not necessary for paired devices.

I Search&Paired Device List
@ Device Type
Indicators appear for different
types of devices. (X
@ Device Name I BD=
Device names appear. oun e seFTore ——@
When no names are found, Search&Paired Device
Bluetooth® addresses appear.
@ Connection Status
[@: Connected [O : Not connected [><: Not found [E]: Not paired

¢ Search&Paired Dev.

O Protection

Indicator appears when registered contents are protected.
@ Profile Status

Indicators appear to show profile status.

Icon | Letter Color |Background Color | Frame Color Status
[HSP_ Blue Gray - Not connected (Not paired)
[HSP_ Blue Gray Blue Not connected (Paired)
EEd | White Green - Connected
[HSP. | Green White Green | Standby for connection
White | Light green - Preferred device
Gray Gray — Not supported

P eceeccccccccccccccoccccoe
(ETTTD @Set Duration to Search for Bluetooth® Devices (L% P.18-20)

I Suspending Bluetooth® Functions

Suspend all Bluetooth® functions connected or on standby
for connection, and disable Bluetooth®.

Main Menu P> Tools p> Bluetooth

1 Bluetooth OFF —» YES

® To return to standby for previously connected function:
Bluetooth ON



Placing Bluetooth® Devices on Standby for
Connection

Main Menu P> Tools P> Bluetooth > Accept Registered

Check functions to be on standby for connection —

(&)[Finish]

® To uncheck, select functions to remove check marks.

I Sending/Receiving Phone Book

Sending
1 Open Phone Book — (x7)[Menu] -
Send to Bluetooth

2 One File Transfer
Send phonebook — Select a recipient device

All File Transfer
Send all phonebook — Select a recipient device =
Enter Phone Password

3 YES

\H

Receiving

Main Menu P> Tools P> Bluetooth »> Receive via Bluetooth

One File Transfer
Receive —» YES

All File Transfer
Receive All = Enter Phone Password = YES = YES

® |f memory becomes full, remaining entries are truncated (Memory
List: C%P.19-25).

P eececcccccccccccccccccoe

ETITD @Set Authentication/Encryption to Send Phone Book Entries
@Enter Password when Sending All Phone Book Entries
(C¥P.18-20)
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I Bluetooth® Functions
[From Jp Main Menu P> Tools p> Bluetooth

M Functions Available in Search&Paired Device Window
> Search&Paired Device — [Menu] —» Select an item (See below)

Item Operation/Description
Register > Enter Phone Password —» Pair devices
devices (C% From Step 3 on P.11-7)
Preferred Set a preferred Bluetooth® device for incoming calls
device ® Available only for headset function compatible

Bluetooth® devices.
® To cancel, perform same operation.

Protect/ Protect/cancel devices. Protection prevents devices from
release being deleted or overwritten
Change > Enter a device name
device name
Delete >YES

Show device name, Bluetooth® address, device class and
supported profile

Description

Add shortcut Create shortcuts (5 P.1-25)
icon

I Use Bluetooth® Headsets for Calls
> Search&Paired Device = Select a device = Headset or Hands-free
— YES — Make/receive a call using Bluetooth® device

11-10

I Use Bluetooth® Device for Listening to Music

> Search&Paired Device — Select a device = Audio — Watch Digital
TV or play back videos or music

® Digital TV/Video sounds are played only by A2DP profile compatible
Bluetooth® devices compliant with SCMS-T copyright protection
standard.

I Use Handset as Modem for Internet Access from PCs

> Search&Paired Device — Select a device = Dial-up

® Handset waits for dial-up connection.

® Refer to a manual for Bluetooth® device for details.
Download utility software (942P) "Modem Wizard" from website below
to PC and install software.
http://panasonic.jp/mabile/support/download/942p/index.html

@ To establish a dial-up connection, see Help on "Modem Wizard."

® Connecting handset to a PC or PDA for Internet access may incur high
packet transmission charges.

I Place Bluetooth® Device on Standby for Dial-up
> Dialup Rgstry Standby — Enter Phone Password — YES — Select
Bluetooth® Passkey text box —» Enter Bluetooth® Passkey



Wi-Fi

Use wireless LAN (Wi-Fi) for Internet connection via home/

public Wi-Fi networks enabling high-speed internet access.

® 942P Wi-Fi function supports IEEE802.11b/g.

@ Separate subscription is required.

@ For details on available access points and public wireless LAN, visit
http://panasonic.jp/mobile/softbank/94 2p/function/wifi.html

I Before Using Wi-Fi
Notes

Wi-Fi connection may automatically switch to 3G depending

on signal condition. Note that packet transmission fees are

incurred. (To set confirmation to appear when switching:

¥ P11-16)

® \Wi-Fi connection is not guaranteed with all Wi-Fi devices.

® Bluetooth® and Wi-Fi are not simultaneously available.

® S! Mail/SMS function unavailable via Wi-Fi.

® Accidental data loss/information leakage may occur during Wi-Fi
transmission. Use security settings (C%P.11-14).

® Wi-Fi is disconnected when Backlight turns off; turn Backlight on to
re-connect to the network.

® \Wi-Fi is not available while abroad.

Radio Wave Interference with Bluetooth® Devices

Bluetooth® and Wi-Fi devices (IEEE802.11b/g) share the same frequency

band (2.4GHz). Radio wave interference occurs if Bluetooth® and Wi-Fi

devices are used in close proximity, causing low transmission speed, noise

or poor connection. If interference occurs, take the following measures:

® Keep 10 m or more between Bluetooth® and Wi-Fi devices.

® Turn off Bluetooth® device when using Wi-Fi device within a radius of
less than 10 m.

1-11
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Getting Started

Checking Information

® Access point information varies by access point.
® Security information may be required.

v

— Access Point Registration/Connection

Complete access point registration/connection.

. 4
Starting Transmission

Transmission is enabled once handset comes into Wi-Fi range.
® Wi-Fi status indicators: (¥P.11-13

I Enabling/Disabling Wi-Fi
1 Press and hold

Wi-Fi status indicator appears (C5P.11-13).

® Alternatively, switch Wi-Fi on/off from Main Menu P> Tools p> Wi-Fi
p ON/OFF

11-12

I Registering/Connecting to Access Points

Following methods are available for registering/connecting
to access points.

Search/ Search access points for registration/connection.
Setting

Manual Manually register/connect to access points.

Setting

AOSS Use AOSS™ (AirStation™ One-Touch Secure System) for

registration/connection. For AOSS™-compatible access

points, press AOSS button on access point device for

automatic setup.

BB Register to BB mobilepoint and set as access point.

mobilepoint | ® The BB mobilepoint profile is saved to handset by
default. For details on BB mobilepoint, visit

http://tm.softbank.jp/english/consumer/wlan/index.html

® Register up to 10 access points.

® User ID and password is required for connecting to pre-registered access
points (Public Wi-Fi Setting: L3 P.11-14).

® For setting/operating access point devices, refer to device manual.

® Wi-Fi connection is not available when access point channel is
set to 12-14 ch and stealth mode.

® Alternatively, search and register access point from Main Menu
p> Tools > Wi-Fi > Access Point Search. Registration is available
after connection.

® Pre-registered access points may be deleted from Profile List if another
USIM Card is inserted. BB mobile point can be easily reconfigured

(CFP11-15).




Access Point Search

Main Menu P> Tools > Wi-Fi b Profile Lists/Settings

1 (Menu] > New Profile + Search&Setting

Select YES when prompted to turn Wi-Fi ON.
List of available access points appears.
® To search again: (&)[Search]

2 Select an access point
3 (e)[Store] = YES

Handset registers access point.

4 (eJICNCT] > YES

Handset connects to access point.

\H

I Access Point List

Wi-Fi Status Indicators
Wi-Fi ON (out of range)

g * Wi-Fi ON (within range)

Eii * During Wi-Fi transmission

* Number of blue arches indicates
signal strength.

@ Access Point Name
Detected SSID (ESSID) appears.
Access point name appears for
a registered access point.

® Registered Networks
" Registered (not connected)
"% Registered (connected)

© Signal Strength
Signal status appears.

O Security Status
Security status appears.

Access Point List
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Manual Registration/Connection

Check respective access point information (SSID, security/encryption type,
encryption key) in advance. For details on access point devices, refer to

Public W-Fi
Setting

Set public wireless LAN on/off

> ON or OFF (= For ON, select ID or Password
— (=)[Edit] = Enter ID or password)

@ Connection with all public wireless LAN services is not
guaranteed.

respective manuals.

Main Menu P> Tools P> Wi-Fi P> Profile Lists/Settings
1 (x7)[Menu] = New Profile - Manual Setting

9 Highlight an item (See below) — (=J[Edit]

Item Operation/Description
Profile Name > Enter an access point name
SSID > Enter the same SSID (ESSID) as access point
m IP Setting Set IP address and DNS server
% P > IP Address Setting or DNS Server Setting
S — (2)[Edit] = Automatically or Manually
3 (—> For Manually, edit respective items)
=1 Security Set security/encryption method according to access point
<. Setting > Select a security type
< - WEP — Enter WEP key —» Select an encryption type

—> Enter encryption key
- WPA/WPA2-PSK or WPA2-PSK — Select an
encryption type — Select an encryption method
—> Enter encryption key
® To cancel security setting: Non

11-14

3 [(®Jistore] » YES

Handset registers access point.

4 (e][CNCT] - YES

Handset connects to access point.



Registration/Connection Using AOSS™

® For details on access point device operations, refer to access point device
manual.

Main Menu P> Tools P> Wi-Fi > Profile Lists/Settings

1 @)Aoss]

® Select YES to register/connect to an access point after
disconnecting from registered access point.

2 Press AOSS button at access point

Press within 120 seconds.
Confirmation appears when setting is complete.

3 @[Store] —> YES

Handset registers access point.

4 (®JICNCT] > YES

Handset connects to access point.

\H

I Functions Available for Wi-Fi

I Functions Available in Profile List/Setting Window
>Main Menu P> Tools > Wi-Fi > Profile Lists/Settings
» (x7)[Menu] »> Select an item (See below)

Item Operation/Description
Connect Connect to a registered access point
>YES
Change Change priority for registered access points
Priority > Select an access point = () to move to target —
(e) = (=)[Finish]

New Profile > Select an item
- AOSS (% From Step 2 (Left)
- Search&Setting (5 From Step 2 on P.11-13)
- Manual Setting (C% From Step 2 on P.11-14)

- Delete this — YES
- Delete selected —» Check access points
— (=)[Finish]

- Delete all — Enter Phone Password — YES

New BB Enter user ID/password to register BB mobilepoint

mobilepoint > Select an item — (=)[Edit] = Enter user ID/password
— (@)[Store]

Edit > Edit items

Copy Copy registered access point

Delete > Select an item

A1anauuo) E

M View Connection Status
>Main Menu P> Tools P> Wi-Fi B> Connection Status
® To update status: (&)[Update]
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I Set Confirmation to Appear when Switching between
Wi-Fi and 3G
<Default> OFF
> Main Menu P> Tools p> Wi-Fi P> Wi-Fi/3G Switch Conf.
P> Switch to Wi-Fi or Switch to 3G > ON

M View MAC Address
>Main Menu P> Tools p> Wi-Fi > MAC Address

11-16

SoftBank Utility Software (Japanese)

Phone Book, Calendar, Tasks, messages, Bookmarks,

Notepads and Data Folder can be transferred to a PC, edited

or managed by using SoftBank Utility Software.

® For details on and downloading SoftBank Utility Software, visit
http://www.softbank.jp/mb/r/sbu/ (Japanese)

® USB cable (not included) is necessary for using SoftBank Utility
Software.

® S! Appli, PC Movies, TV, Lifestyle-Appli, Books, Customized Screen,
Templates, Font and Other Documents cannot be backed up.

® Copy protected files may not be backed up.

® Set USB Mode to Communication Mode (C#P.11-17).
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USB (Japanese)

Connect handset to a PC via USB cable (not included)
specified by SoftBank for data transfer or data
communication.

ISetting USB Mode

<Default> Communication Mode
Main Menu P> Settings P> Connectivity p» USB Mode

1 Select an item (See below)

Item Operation/Description
Communication Packet transmission, 64K data transmission, data transfer

Mode and calls with USB handsfree compatible devices are
available (C¥P.11-16)

microSD Read/write data on microSD Card (C%P.10-23)

Mode

MTP Mode  Transfer/delete music data via Windows Media® Player on

PC (C5P9-4)

ITransferring Data via USB Cable

® Transfer data using SoftBank Utility Software (C%P.11-16).
@ Transferring data in microSD Mode (% P.10-23)

I Data Communication via USB Cable

Use handset as a modem for Internet access by connecting
handset with a PC.

® Download utility software from URL below and install on PC.
http://panasonic.jp/mobile/support/download/942p/index.html

1 Install "USB = -1/ X (USB Driver)" and "Modem
Wizard" from Utility Software (942P) to a PC

2 Set handset to Communication Mode (L5 Left), and

connect handset to PC via USB cable

® Power up handset before connecting to PC via USB cable.

3 Startup "Modem Wizard", and operate communication

setup

® “Modem Wizard" enables you to set up APN and dial-up easily.
For setup/starting procedures, see "Modem Wizard" Help.

® Connecting handset to a PC or PDA for Internet access may incur high
packet transmission fees.

A1andauuo) E
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AV Output 3 Connect Video Output Cable to video/audio input

View the following on a TV set or other devices using a terminal on TV set

SoftBank-specified Video Output Cable (not included): Video

Call images, Digital TV images, still images/videos saved on 4 Open an image file on handset
942P. ® To toggle image size:

® View AV-output-compatible S! Appli on TV.

a ® Some images cannot be displayed on TV.
I connedmg Handset to TV ® Display size setting is not available for some TV sets.

® To use Video Output Cable (not included), Stereo Earphone Conversion
Cable (not included) is required.

3 . Video Output Cable
o L]

jal Video @Qm < A0 )mm:

E_- Audio L ©‘_Wh|te 4

< Red

AudioR O ===

External Port

1 Open External Port Cover

2 Connect Video Output Cable to handset using Stereo
Earphone Conversion Cable

® To connect Video Output Cable to Stereo Earphone Conversion
Cable: C%P1-4

11-18
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Changing Phone Password
Security Functions

USIM PINs

Keyguard.

Privacy Key Lock

Personal Data Lock.

Secure Remote Lock

Key Pad Dial Lock

Side-keys Guard .

Additional Lock Function
Restricting Calls/Messages..

Hiding Call Logs and Sent/Received Address List

Secret Mode/Secret Data Only

Setting Secret Mail .

Mail Security

Call Restrictions

Delaying Ringtone ..

Rejecting Unknown Callers

Rejecting Calls without Caller ID

Reset Settings
All Reset
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12-2

Y

Changing Phone Password
<Default> 9999

Change Phone Password as required.
® For Phone Password details: C%P.1-32

Main Menu P> Settings P> Security
p> Change Phone Password

1 Enter current 4-8-digit Phone Password

2 Enternew 4-8-digit Phone Password = YES

Security Functions
| usim PINs

® For more information about PINs: £ P.1-3

® Emergency numbers (110, 119, 118) are not dialable in PIN/PIN2,
PUK/PUK2 entry window.

PIN Authentication

Activate to require PIN entry each time handset is turned
on.

Main Menu P> Settings P> Security P> PIN Authentication
1 Enter Phone Password —» PIN Authentication

2 ON or OFF
3 Enter PIN



Changing PIN/PIN2
® Set PIN Authentication to ON before changing PIN (C3P.12-2).
Main Menu P> Settings P> Security »> PIN Authentication

1 Enter Phone Password —» Change PIN or
Change PIN2

2 Enter current PIN/PIN2
Enter new PIN/PIN2

w

4 Reenter new PIN/PIN2

\H

PIN Lock & Cancellation (PUK/PUK2)

PIN Lock or PIN2 Lock is activated if PIN or PIN2 is

incorrectly entered three times. Cancel PIN Lock or PIN2

Lock by entering PIN Unblocking Key (PUK/PUK2).

@ For information about PUK/PUK2, contact SoftBank Mobile Customer
Center, General Information (C%P.19-34).

1 In PIN lock mode, enter PUK/PUK?2
2 Enter new PIN/PIN2
3 Reenter new PIN/PIN2

® |f PUK/PUK?2 is incorrectly entered ten times, USIM Card is locked and
handset is disabled (turning off power counts as one incorrect entry).
Write down PUK/PUK2.

® For procedures required to unlock USIM Card, contact SoftBank Mobile
Customer Center, General Information (C%P.19-34).

-
N
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I Keyguard

<Default> OFF

Lock handset keys to prevent accidental operation except
when turning power on/off or answering incoming calls.
® While set, (& appears in Standby.

1 In‘Standby, press and hold (o)

® To cancel Keyguard, repeat operation.

While Keyguard is Active

® Emergency numbers (110, 119, 118) are dialable. Entered numbers do
not appear on Display. Once numbers are dialed, Keyguard is canceled.

® Press to disable Calendar event tone or Alarm.

® Keyguard can be canceled even during a call.

® Turning off power does not cancel Keyguard.

I Privacy Key Lock

<Default> OFF

Set Privacy Key Lock to require Phone Password for using
handset except for turning handset on/off and answering
calls.

® While locked, [l appears in Standby.

Main Menu P> Settings P> Security P> Privacy Key Lock

Enter Phone Password

® To cancel Privacy Key Lock, enter Phone Password in Standby. If
Phone Password is incorrectly entered five times, handset turns off.

While Privacy Key Lock is Active

® Emergency numbers (110, 119, 118) are dialable.

® Only phone numbers appear on Display for incoming calls.

® Message ringtones or Alarm tones are disabled.

® Calendar event tone or Alarm is disabled.

® S! Quick News and some Internal Display indicators do not appear.
They appear after Privacy Key Lock is canceled.

® Turning off power does not cancel Privacy Key Lock.




I Personal Data Lock

Set Personal Data Lock to prevent others from reading or
tampering with your personal information in Phone Book or
Data Folder. Activate to require Phone Password for
accessing personal data.

M Locked Functions/Data

- SI Appli

- Phone Book search/saving/setting

- Memory Manager/ Memory Status
(Phone Book)

- Account Details

- SI Mail/SMS/PC Mail

- Yahoo! Keitai viewing/setting

- PC Site Browser viewing/setting
- Bookmarks/ Saved Pages

- BookSurfing®/e-Book Viewer

- Notepad - Mobile Widget

- Calendar - SI Quick News

- Tasks - S! Information Channel/Weather
- Shorteuts - Content Key obtaining/backup

- Event Indicators - Voice Dial

- Camera/Video Camera - S GPS Navi

- Variety Photo Viewer - Data Folder*

- Lifestyle Appli - Music Player

- microSD Backup - Digital TV

- Bar Code Reader
- Receive via Infrared/Bluetooth®
- 1C Data transmission

- Answer Phone
- Voice Recorder
- Customized Screen

- Voice Announce - Alarm

- Dictionary - Reset Settings/All Reset
- Post blog - Software Update

- Wi-Fi

* Font setting is available.

\H

Activating/Canceling Personal Data Lock

<Default> Deactivate

® While locked, gappears in Standby.

Main Menu P> Settings P> Security P> Personal Data Lock

Enter Phone Password = Activate/Deactivate

® To cancel Personal Data Lock, repeat operation. If Timer Lock at
Close is set, password entry is requested when handset is opened.

Canceling Personal Data Lock Temporarily

When Phone Password is entered, gdisappears and disabled functions

become temporarily available.

® Once handset returns to Standby while no functions are active,
Personal Data Lock is active again.

@ Some functions remain unavailable. Deactivate Personal Data Lock to
use the following:
- Receiving IC data - Reject unknown

® While Personal Data Lock is set, some indicators do not appear in
Standby. They appear after lock is canceled.
® Turning off power does not cancel Personal Data Lock.

-
N
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Customizing Personal Data Lock

Enable/disable Alarm, incoming message notification, etc.

while Personal Data Lock is active.

Main Menu P> Settings P> Security > Personal Data Lock
Enter Phone Password —» Customize —» Select an
item (See below)

\H

Item Operation/Description

Enable/disable Alarms (Calendar, TV timer, or other alerts)

or TV Timer Recording.

> Select an item = Accept (Enable) or Not Accept
(Disable)

Alarm Tone

Incoming Call Show/hide Event Indicator (incoming messages) or Phone
Act Book entry information (incoming calls).
> Select an item
- Incoming Message — Accept (Show indicator)
or Not Accept (Hide indicator)
- Phone Book Available — Accept (Show Phone
Book Entry information) or Not Accept (Hide
information)

Display/Tone Enable/disable Display settings, ringtones or indicators.
> Select an item

- Internal Display —» Accept (Enable Display
Settings) or Not Accept (Disable)

- Ring Tones = Accept (Enable Sound Settings) or
Not Accept (Disable)

- S! Quick News — Accept (Show information) or
Not Accept (Hide information)

- 5! Info Ch./Weather — Accept (Show indicators)
or Not Accept (Hide indicators)

- Widget Contents = Accept (Show widgets) or
Not Accept (Hide widgets)

Activating Personal Data Lock when Closing Handset

<Default> OFF
Set Timer Lock at Close to automatically activate Personal
Data Lock when specified time has elapsed after handset is
closed.

Main Menu P> Settings P> Security p> Timer Lock at Close

1 Enter Phone Password

2 Personal Data Lock — Select a time

Confirmation appears asking whether to activate Lock OFF at Open.
® While set, g appears in Standby.
® \When OFF is selected, setting is canceled.
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Showing Personal Data Lock OFF Window when I Secure Remote Lock

Opening Handset
If handset is lost or stolen, remotely lock handset from a PC

<Default> OFF | or mobile. If Secure Remote Lock is active, all operations are

Main Menu P> Settings P> Security > Lock OFF at Open unavailable except to turn handset on.
® For service details and user agreement/registration, visit SOFTBANK

1 Enter Phone Password MOBILE Corp. Website (http://www.softbank.jp) or My SoftBank.

2 Personal Data Lock = ON Accessing My SoftBank from Handset (Japanese)
For service details, visit SOFTBANK MOBILE Corp. Website.

@ When Timer Lock at Close and Lock OFF at Open are both active, Main Menu P> Yahoo! p> Menu List »> My SoftBank

canceling Personal Data Lock when opening handset temporarily P English
cancels lock. However, lock activates again when specified time elapses | | ¢ojiow onscreen instructions
after closing handset.

-
N

® Emergency numbers (110, 119, 118) are dialable even while Secure
Remote Lock is set.
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Showing Messages during Secure Remote Lock

<Default> OFF

Set Display message to appear when Secure Remote Lock is
active.
® Use preset message or create a message.

Main Menu P> Settings P> Security > Lock Message

1 Enter Phone Password
) Display Setting — ON

I Save Lock Messages
> After Step 1, Message —» Enter a message

I Key Pad Dial Lock

<Default> Deactivate

Allow dialing only from Phone Book entries and lock dialing
with keypad. Unauthorized use of handset can be prevented.
@ While locked, £ &g appears in Standby.

I Unavailable Operations
- Dialing with keypad

- Phone Book (saving, editing, deleting, copying from microSD Card, and
sending/receiving via Infrared, IC transmission and Bluetooth®)

- Sending S! Mail/SMS (manually entering addresses)

I Available Operations
- Dialing from Phone Book or Voice Dial

- Dialing from Redial, Outgoing Call Logs, Incoming Call Logs, Sent
address, or Received address (only phone numbers/mail addresses saved
in Phone Book)

Main Menu P> Settings P> Security > Key Pad Dial Lock

Enter Phone Password
® To cancel Key Pad Dial Lock, repeat operation.

® Emergency numbers (110, 119, 118) are dialable even while Key Pad
Dial Lock is set.
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I Side-keys Guard

<Default> OFF
Set Side-keys Guard to disable side key operations while
handset is closed.

Main Menu P> Settings > Phone Settings
) Side-keys Guard

OoN

While Side-keys Guard is set, ﬂ@‘ appears in Standby.
® To activate side key operations while handset is closed, select OFF.

® \When Menu Icons is set to Basic or Customize, press (@] in Standby
— Press and hold to toggle ON/OFF.

IAdditionaI Lock Functions

M IC Card Lock
Deactivate Osaifu-Keitai® functions (C%P.13-12).

M Remote Lock
Deactivate Osaifu-Keitai® functions remotely (C%P.13-12).

Restricting Calls/Messages
I Hiding Call Logs and Sent/Received Address List
<Default> ON
Main Menu P> Settings P> Incoming Settings P> Call Logs

1 Enter Phone Password

2 Select an item (See below)

Item Operation/Description
Incoming Show/hide Incoming Call Logs/Received address list
Outgoing Show/hide Redial/Outgoing Call Logs/Sent address list
3 OFF

® While Incoming Call Logs is OFF, Answer Phone (Voice Calls) does not
play. Selecting Missed Call indicator does not show Incoming Call Logs.

-
N
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I Secret Mode/Secret Data Only

<Default> Deactivate

Phone Book entries and calendar events saved as secret

data appear only when Secret Mode/Secret Data Only is

active.

® Set Phone Book or Calendar events as secret data (Phone Book:
% P.4-7, 4-8 | Calendar events: % P.13-5)

Main Menu P> Settings p> Security

1 Select an item (See below)

Item Operation/Description

Secret Mode View all data including secret data
® While set, g appears in Standby.

12 Secret Data  View only secret data
= Only ® While set, gflashes in Standby.
2
&
& 2 Enter Phone Password
E For Secret Data Only, number of saved secret data appears.
= I Cancel Secret Mode/Secret Data Only
> In Standby, (=) or follow Step 1 above
° gdisappears.
® When widgets are shown, (=) to hide and press (=) again.
12-10

I Cancel Secret Mode/Secret Setting
> In Phone Book/Calendar event window, (x7)[Menu] = Release secret

® Select whether to save data edited/saved in Secret Mode as secret data.
Data saved/edited in Secret Data Only are saved as secret data.
® Turn off handset to cancel secret setting.

PP eececcccccccccccccccccoe
ETITD @Disable Learning for Secret Mode/Secret Data Only (C%P.18-11)
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I Setting Secret Mail
<Default> ON

Hide messages to/from secret Phone Book entries.
® Even if Secret Mail Display is set to OFF, secret mail appears when Secret
Mode/Secret Data Only is active.

1 — Settings
2 Universal Settings — Secret Mail Display
3 Enter Phone Password

A OFF

® When both Spam Filter and Secret Mail Display are set, messages from
Phone Book entries saved as secret mode are sorted into Spam Folder
(Safe List: % P.14-18).

I Mail Security

Set handset to require Phone Password for opening mail
boxes or operating Server Mail.
® [ appears for set mail boxes and Server Mail box.

1 - Settings
2 Universal Settings —» Mail Security
3 Enter Phone Password = Check items — (=2)[Finish]

I Set/Cancel Mail Security by Folder (Incoming Mail or
Sent/Unsent)

> (&) = Incoming Mail or Sent/Unsent — Highlight a folder =
(x7)[Menu] = Mail Security — Enter Phone Password

® [T appears for set folders.

-
N
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I Call Restrictions

Reject/accept/forward calls from specified phone numbers,
or restrict calling unspecified phone numbers.

1 (@) - Search Phone Book
2 Select an entry = (¥7)[Menu] = Restrictions
3 Enter Phone Password

4 Select an item (See below)

Item Operation/Description

Restrict Allow calls only to specified numbers

Dialing

Call Rejection Reject specified numbers

Call Accept from specified numbers only
Acceptance

Call Automatically forward specified numbers
Forwarding @ Set destination numbers (Call Forwarding: C3P.2-17)

® To cancel, repeat operation.

M View/Cancel Phone Book Restrictions

>Main Menu P> Phone P> Restrictions P> Enter Phone Password
P> Select an item* P> Select a Phone Book entry B> Select a number
» YES

* Sk appears for set item.

@ Highlight an item, (37)[Menu] — Release Settings — YES to cancel
restriction on all specified numbers.

12-12

® Missed call indicator appears in Standby for calls from rejected
numbers.

I Delaying Ringtone

<Default> OFF
Delay ringtone/vibration for Voice/Video Calls from unknown
numbers.

Main Menu P> Settings P> Incoming Settings
P> Ring Time Settings > Ring Starting Time

1 ON — Enter start time

I Hide Missed Call Records (Disconnected during Ringtone
Delay)

>Main Menu P> Settings P> Incoming Settings
P> Ring Time Settings »> Missed Calls Display »> Not Display
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I Rejecting Unknown Callers
<Default> Accept
Main Menu P> Settings P> Security > Reject Unknown

1 Enter Phone Password —» Reject

I Rejecting Calls without Caller ID

<Default> Accept
Reject calls without Caller ID or from pay phones.

Main Menu P> Settings P> Security p> Call Setting w/o ID

1 Enter Phone Password

2 Select an item —» Reject

Reset
I Reset Settings

Cancel custom settings and return handset functions to their
default settings.

Main Menu P> Settings P> Security p> Reset Settings
1 Enter Phone Password —» YES

® Some default settings may not be restored.
® Reset Settings cancels Navi Appli settings in S! GPS Navi. Set a
Navi Appli to activate from Select Navi Appli (5 P.18-27).

-
N
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I All Reset

Cancel custom settings and return handset functions to their
default settings; clear all Phone Book/Data Folder entries
etc.

Main Menu P> Settings P> Security > All Reset
1 Enter Phone Password = YES — YES

Handset automatically turns off and restarts.

® Fully charge battery ( EI) beforehand.
® Phone Password is reset to default.
® USIM Card/microSD Card files are not affected.
® Data transmission settings (set via PC) are not affected.
® Non-restorable items when deleted by All Reset:
- Customized settings, Call Logs, downloaded S! Appli, etc.

-
N
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Calendar

View by day, week or month; set Alarms for events.

I Opening Calendar

Main Menu P> Tools P> Calendar

Current month appears.

® When a date with Calendar events is selected,
number of AM and PM events and up to three
contents appear.

® Press (&@)[Prev.] or (aa)[Next] to show
previous/next month calendar.

® To switch Monthly/Weekly view: C5P.13-4

B 2010/ 2/ S5(Fri)
Sun Mon Tue Wed Thu Fri Sat

7/ 8 9/10/ 1) 1213

\H

I Creating Calendar Events
Save up to 1000 entries.
Main Menu P> Tools p> Calendar

§39 to highlight a date —
(=)[New] = Schedule

14/ 15| 16/ 17| 18/ 19 20

1 2TBP%

28

F] E 1
©11:35 Scheduled
£111:40 Shopping
1112:30 Meal

2 Select an item (See below)

f¢  Edit schedule

PlScheduled (No Title)
l#*Location

@Whole day OFF
@Date (from)

3010;’ 2/ 510:10
Dlate s

200/ |/ B3
Oﬂenea-tr BB OFF
IGiAlarm OFF
MTone Clock Alarm Tong

“Contents

el et
Monthly View

Item Operation/Description

Selecticon/ > Select an icon —» Edit subject

Edit summary

Edit location > Enter location

Whole day > OFF or ON

setting ® When ON is set, Alarm goes off at 0:00 a.m.

Date (from) > Enter start date and time

Date (to) > Enter end date and time

Repeat > Select a repeat type —» (For Select day, check days
— (=)[Finish))

Alarm > Select an Alarm type (—> For ON/Set time, enter time)

® Alarm Tone: C¥P.13-6

Alarm tone > Select an Alarm tone type —» Select a folder — Select
an Alarm tone

Contents > Enter event description




my

3 (=)[Finish]

Calendar Event Indicators

Following indicators appear in Calendar Window.

M (Blue): Morning event

M (Orange): Afternoon event

__ (Underscore): Event that lasts for two days or longer

® Following indicators appear on Display.

[&] : Alarm @ : Monthly
& : Daily : Yearly
: Weekly

® (Calendar events between 00:00 on 2000/01/01 and 23:59 on
2037/12/31 can be saved on handset.

® Alarm tone does not sound when Privacy Key Lock or Personal Data
Lock is set. However, settings can be changed even while Personal Data
Lock is set (C%P.12-6).

\H

I Saving Holidays/Memorial Days

Save up to 100 entries (one entry a day) each for Holidays
or Memorial days.

Main Menu P> Tools p> Calendar

1 (Highlight a date —) (&2)[New] — Holidays or
Memorial days

2 Select an item (See below)

Item Operation/Description

Date setting > Enter a date

Repeat > Select a repeat type
® 1 time does not repeat Holidays/Memorial days
events.

Edit holiday/ > Enter description
anniversary

3 (&)[Finish]

Indicators
Holidays appear in red.
Memorial days are marked with a red circle.

® Following indicators appear in Calendar/Calendar Event List Window:
¥ :Holidays  / : Memorial days : Yearly repeat

13-3
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IViewingIEditing Calendar Event Details

Main Menu P> Tools P> Calendar
1 B toselecta date

ping
E112:30~13:00
lile=r=rar~

Calendar Event List

Select an event

. @ Summary
Detailed schedule appears. :ﬁthu‘Iled o
. . . . o
@ To edit: (@)[Edit] —» Edit selected item | 5p 2% %rrons

2010/ 2/ 5(Fri) 11:35

R TBD

(Schedule: £ From Step 2 on P.13-2/
Holiday, Anniversary: % From Step 2 on

P.13-3) Repeat OFF
GAlarm OFF
“Contents
Scheduled

Calendar Event Details

I Calendar Functions

(From ] Main Menu P> Tools b Calendar

M Functions Available in Calendar Window
> Highlight a date = [Menu] —> Select an item (See below)

Operation/Description
Create a new entry (C¥P.13-2, P.13-3)

Item
New

Item Operation/Description

Weekly Toggle Monthly/Weekly view

display/

1 Month

Icon display  Entries in category of selected icon appear
> Select an icon

No. of Display number of saved Schedule, Holiday or Anniversary

schedules entries

Add shortcut Create a shortcut (C3P.1-25)

icon

Sendalllr  ((¥P11-3)

data

AlllC (C5P.11-5)

transmission

Delete past  Delete past entries/items, prior to highlighted date
> Select a category to delete = YES

Delete all > Enter Phone Password —» Select an item — YES

Reset Restore deleted Holidays

holidays > YES

M Functions Available in Calendar Events List/Details
> Select a date (= Select a Schedule, Holiday or Anniversary) =
(¥7)[Menu] — Select an item (See below)

Item Operation/Description
New Create a new entry (C¥P.13-2, P.13-3)
Edit Edit selected item (C% Left)

Copy Copy an entry to another day

> Enter date and time to copy an entry to
Calendar Switch from Icon display to Calendar display
display
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Item Operation/Description TaSkS

Icon display E;Z';Zé? ;stiec%(:]ry of selected icon appear Make quick notes of task to manage in Task list.

Set secret Activate/deactivate Secret Mode -

mode/ > YES (— For Set secret mode, enter Phone Password) I Savmg a Task

Release ® Secret entries appear only in Secret Modle or -

secret Secret Data Only (C3P.12-10). Main Menu p> Tools b Tasks

Cmt)eT;t)gs: Igz;rt;;lﬁn%djﬁ[:)and details to message text (% From 1 [New] - Select an item (See belovv)

SendIrdata (C%P11-3) ° Tq check saved Tasks, select a Task. To edit, press (@)[Edit] in detail

SendallIr  (C%P11-3) window.

data Item Operation/Description

IC (C5P.11-5) Edit Tasks > Enter content

transmission Due date > Select how to enter due date = Enter due date

AlliC (CFP.11-5) @ Select No date to enter none.

transmission Priority > Select a priority level

Copy to Copy an entry to microSD Card Category > Select a category

microSD >YES . Alarm > Select an Alarm type (= For ON/Set time, enter time) m
@ To display data on microSD Card: C5°P.10-20 ® Alarm Tone: C%P.13-6 -

Delete this > YES Alarm tone > Select an Alarm tone type = Select a folder = 8

Delete past  Delete past entries/items, prior to highlighted date Select an Alarm tone w
> Select a category to delete = YES

Delete select > Check entries to delete = (=2)[Finish] = YES 2 [Finish]

® When content is not entered, Tasks cannot be saved.

® Alarm tone does not sound when Privacy Key Lock or Personal Data
Lock is set. However, settings can be changed even while Personal Data
Lock is set (C3P.12-6).
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I Using Tasks

In Tasks window, press (x7)[Menu] for following operations.

\H

Alarms
IAIarm Tone

IEEI0) DJELE D When scheduled time arrives, alarm tone sounds and
Mo Create a new entry (EZP13-5) Notification Light illuminates.
Edit Edit an entry (3P 13-5) ® For Calendar events and Tasks, alarm message and animation
Change Change status indicator shown in Tasks list . corresponding to selected icon appear on Display.
status > Select a status (—» For Completion, select an item —»
Enter Completion date) I To Stop Alarm Tone for Calendar Events, Tasks or Alarm
® Overdue status indicator turns red. Press any key.
:::)ev;obr); > Select a category Mi;sed Alarm A A |
- - "Missed alarm" Event Indicator appears in Standby for alarms missed
sl Sort lst by due d.a.te’ entry order, status, efc. during Privacy Key Lock, Personal Data Lock or Infrared transmission once
> Select a condition lock led or t o ds. Select indicator to vi tent
ocks are canceled or transmission ends. Select indicator to view content.
Add shortcut Create a shortcut ([ P.1-25)
icon
Send Ir data (C%P.11-3) ® \Vhen one or more Alarms are set to the same time, alarm sounds in
Send all Ir (CFP.11-3) the order of : "Alarm" — "Timer Recording" — "Tasks" —
data "Calendar" = "Timer Watching"
IC transmission (C%P.11-5) For Tasks, "Missed alarm" indicator appears.
AlliC (C5P.11-5) @ If alarms are set for more than one Calendar event, press (¥7)[Next]
transmission when alarm sounds to toggle Calendar event entries.
Copy to Copy a Task to microSD Card
microSD >YES
® To display data on microSD Card: % P.10-20
Delete this > YES
Delete select > Check entries = (=)[Finish] = YES
Delete Delete an entry in Completion status
completed > VYES
Delete all > Enter Phone Password —» YES
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I Setting Alarm

Set up to 12 alarms. Alarm tone sounds at the specified time
once, everyday or weekly as set.
® i appears in Standby when Alarm is set.

Main Menu P> Tools P> Alarms
1 Highlight an Alarm — (=)[Edit]

F¢ Edit Alarm clockl

f.'.JReneat OFF
2Tone Clock Alarm Tone
EVolume Level 4

GrrerednB e

2 Select an item (See below)

Item Operation/Description
Alarm Activate or cancel Alarm
> ON or OFF
Time > Set Alarm time
Repeat > Select a repeat type (— For Select day, check days
— (=)[Finish))
Tone > Select an Alarm tone type —» Select a folder =
Select an Alarm tone
Volume > (B) to set Alarm tone volume
Snooze When Snooze is set to ON, Alarm tone sounds for 60
seconds, repeating up to six times at five minute intervals.
> ON or OFF (— For OFF, enter time)
Prefer Set Manner Mode or Alarm priority.

manner mode > ON or OFF

3 (=)[Finish]

Alarm Indicators
® Following indicators appear:
IE] : Repeats daily : Repeats weekly

I Cancel & Reactivate Alarm

> In Step 1 (highlight an Alarm), [Menu] —> Select an item = YES
@ (Cancel or reactivate an alarm entry as required.

® Highlight an entry = (@) to reactivate/cancel Alarm.

Snooze Function
If ON, press any key; Snooze window appears. To cancel Alarm, press (—=).

® Alarm tone does not sound when Privacy Key Lock or Personal Data
Lock is set. However, settings can be changed even while Personal Data
Lock is set (C5P.12-6).
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Calculator

® Calculates up to 10 digits.

Main Menu P> Tools P> Calculator

Y

Operation Assigned key
Number (0-9) | (© - (D
+ E]
- ©
X ®
+ @
= (o)
Decimal point
%
Clear
Example:
-17+28.5=11.5
©) E (o)

Notepad

Save up to 20 notes.

I Saving a Note

Main Menu P> Tools p> Notepad
1 <Not Recorded>

® Select a saved note to view content.
(@)[Edit] to edit.
Enter text

® Up to 256 double-byte or 512 single-byte
characters can be entered.

Fi¢ Notepad 1/2

il
El<Not Recorded>
El<Not Recorded>
LI <Not Recorded>
E<I|ot Recorded>
Not "=y
oot B0
[El<Not Recorded>
[El<Not Recorded>
[ <Not Recorded>
[E<Not Recorded>
[ <Not Recorded>
W <Not Recorded>

o T

Notepads Window
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INotepad Functions Osaifu Keitai®
L . "Osaifu-Keitai®" is a range of IC Card-based services used
In Notgpad list window, press (3)[Menu] for following by Osaifu-Keitai® compa?ible handsets. Make purchases
operations. . . .
using e-money or e-ticketing. Hold handset up to a reader/
Item Operation/Description writer to pay for your purchase.
Edit Edit a saved note . e
Compose Insert Notepad text to message (L% From Step 2 on W Osaifu-Keitai® Terms
message P.14-4) Osaifu- A contactless IC Card technology to read/write data by
Edit schedule Copy a note to Schedule to create a Calendar event Keitai® holding an IC card up to a reader/writer
> Schedule — Save a new note (C3 From Step 2 on IC Card An IC chip embedded in Osaifu-Keitai®-compatible handsets
P.13-2) Lifestyle- | Applications to use Osaifu-Keitai®. Some applications are
f\dd shortcut Create a shortcut (C%°P.1-25) Appli preinstalled.
icon
Send Ir data (C%P.11-3) Precautions
% Sendalllr  (C¥P11-3) . . .
data ® Data saved in IC Card vary by service content and usage history.
IC transmission (C5P.11-5) Procedures to delete IC Card data vary by Lifestyle-Appli. Contact
AlliC (CFP11-5) Osaifu-Keitai® service providers for details.
transmission ® SoftBank is not liable for damages from accidental loss or alteration of IC
Copy to Copy a note to microSD Card Card data or settings.
microSD > YES ® |C Card data can be misused if your Osaifu-Keitai® compatible handset is
® To display data on microSD Card: % P.10-20 lost or stolen. SoftBank is not liable for any resulting damages.
Notepad Info Display entry date, latest modified date and category of ® Downloading Lifestyle-Appli and using applications may incur high
note packet transmission charges.
Category > Select a category
® When no category applies, select None.
Delete this > VYES
Delete > Check notes = (=2)[Finish] - YES
selected
Delete all > Enter Phone Password = YES




Getting Started

Download Lifestyle-Appli via Internet website.

— Downloading Lifestyle-Appli ——

\H

I Downloading Lifestyle-Appli

Main Menu P> Tools P> Osaifu-Keitai P> Lifestyle-Appli

v

Activate Lifestyle-Appli to complete registration or customize
settings.
@ Make deposit into account, check payment records or balance, etc.

— Registration/Settings ——————

1 Download = YES

Select a Lifestyle-Appli
® Lifestyle-Appli is saved to Data Folder.

I Activating Lifestyle-Appli

® Keep a copy of service passwords/customer service contact, etc. in a
separate place.

® Lifestyle-Appli cannot be activated during a call or while another
S! Appliis active.

13-10

Main Menu P> Tools P> Osaifu-Keitai P> Lifestyle-Appli
1 Selecta Lifestyle-Appli

2 Toexi, (—) —» Stopped

® Alternatively, Main Menu P> S! Appli P> Osaifu-Keitai
) Lifestyle-Appli
or
Main Menu P> Data Folder P> Lifestyle-Appli
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: : | Note |
I Reader/Writer Transactions ® Data may be unreadable if a metal object, etc. is between %) logo and
® Complete registration/settings and charge your account beforehand. reader/writer. ] o ) . )
@ There is no need to activate a Lifestyle-Appli during transaction. ® Even though Osaifu-Keitai® is available while handset is off, Lifestyle-

Appli does not activate. However, if battery is left uncharged after
warning tone sounds, Osaifu-Keitai® may become disabled. Charge
battery beforehand.

® When handset is held up to reader/writer, handset may show a message
or vibrate depending on service. S! Appli, Messaging or Internet may
also activate automatically. To avoid such cases, set the functions not to

1 Hold £ logo up to reader/writer

® \When IC Card Notification Light is ON,
Notification Light illuminates (C%P.18-10).
® Hold handset parallel to reader/writer.
Try moving handset around if recognition is

slow. activate during transactions (% P.18-26).
® Check scan result on reader/writer display. 9 0000600006000000600006es
® Osaifu-Keitai® can be used during a call or i )
Internet transmission (May require extra (ETITD @Disable Handset Response to Commands from Reader/Writer
time.). (C5°P.18-26)

£
13

g
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w
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w
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I IC Card Lock
Activating IC Card Lock

<Default> OFF
® While set, %; appears in Standby.

1 Press and hold — Enter Phone Password

® Repeat the step as required to unlock.

® Alternatively, Main Menu P> Tools P> Osaifu-Keitai
P> IC Card Settings > IC Card Lock or Main Menu P> Settings
» Security > 1C Card Lock

13-12

Remote Lock

<Default> OFF
@ Save up to three phone numbers to enable Remote Lock.

Main Menu P> Tools » Osaifu-Keitai p> IC Card Settings
» Remote Lock

1 Enter Phone Password = ON

2 Select an item (See below)

Item Operation/Description
Numbers to Save numbers to activate Remote Lock
Permit > <Not Recorded> —» Enter phone numbers —

(=)[Return]

@ To save numbers from Phone Book/Incoming Call
Logs or to use a payphone number: (7)[Menu] —
Refer to or Payphone

Specify the number of incoming calls for activating IC

Card Lock

> Enter a number

# of Incoming
Call

3 ([=)[Set]
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Activating Remote Lock

(DCall 942P from one of the specified numbers (Send Caller ID)

(@Hang up after 942P receives the call

(®Repeat D-@ until specified number of incoming calls is reached (within
three minutes)

® After specified number of incoming calls, IC Card Lock is set and a
message informs you IC Card Lock is activated.

® When setting IC Card Lock, call 942P from the same specified phone
number. Incoming calls from different phone numbers cannot be
counted.

® Specified incoming calls may not be counted when Call Forwarding is
active.

® Remote Lock is not available when ring time for Answer Phone is set to
0 or Driving Mode is active.

® When Answer Phone activates, counted number of incoming calls are
reset.

Dictionary (Japanese)

Use 5 —% A TOOL<EZE> to access dictionaries (i ER/\
T - FFEFE and FHF EEEEES).

® 7 —% A TOOL<EEE> is an S! Appli.

Main Menu P> Tools p> Dictionary

1 Read s2& (disclaimer) =& OK
4r—4% A TOOL<EEE> activates.
® To disable B&:
Uncheck 77 ZUREEIBFIC FICZT T Bo (Always show
disclaimer when accessing dictionaries)

2 (@) = Enter a word

Search results appear.
® To scroll pages: (99
® To switch dictionaries: C1D/(3)
(In Horizontal Open Position: C1D/(7))
® To search again: [ﬁ%]
(In Horizontal Open Position: (%))

3 Select a word
Definition appears.

4 To end, (=) - Stopped

@ While Dictionary application is active, press (&2)[ X = 2. —] for useful
functions.

® Word search is available while composing messages or viewing sent/
received messages or website contents (C%P.14-8, P14-23, P.15-13).
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Sound Recorders
IVoice Recorder

Set recorded sounds for ringtones.
® Record for about 60 seconds each.

Main Menu P> Tools P> Sound Recorders P> Voice Recorder
1 YES

Recording starts.

2 (@)[Stop)/e7a/(=) (= OK) to stop recording

Recorded sounds are saved in Ring Songs&Tones folder.

13-14
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I Voice Announce

Set recorded sound for on hold tone/holding tone, Alarm,

Calendar event alarm, Tasks alarm, ringtones, Answer Phone

message, Timer Watching (Digital TV), Ring Songs&Tones

Play List.

@ Record only one item for about 15 seconds.

® Select Voice Announce in individual window to set Voice Announce as
specific tone.

Main Menu P> Tools »> Sound Recorders p> Voice Announce

1 Record

Recording starts.
Tone beeps five seconds before recording ends.

2 (@)[Stop] to end recording
Tone beeps twice and previous screen returns.
® To play back: Play
® To delete: Erase — YES



Bar Code Reader

Scan barcodes (JAN) or QR Codes with built-in camera.
Access websites, send messages, etc. from QR Codes.

JAN Codes
JAN Code is a one-dimensional bar code denoting numerals with bars
and spaces of different widths.

QR Codes

QR Code is a two-dimensional bar code containing
information.

Example: SoftBank mobile phones

ElyE
i

I Scanning Barcodes

® Up to five items can be saved.
® For split data, up to 16 QR Codes can be scanned at a time and saved as
one item.

Main Menu P> Tools P> Bar Code Reader p> Scan Barcodes

1

Frame barcode in the center of Display

® To adjust Display brightness: (7)[Menu] = Brightness —
Adjust to -3 (dark) - +3 (light)

® To zoom: ()

® To use Focus Lock: (@)

\H

2 (e)[Start]

Scanning starts, and scanned results appear when completed.
® For split data, OK — Repeat Step 1 and 2
® To use scanned data: £ Step 2 on P.13-16

(x7)[Menu] = Save result » OK
® To start over: —> YES

® Handset cannot read barcodes or two-dimensional codes other than
JAN/QR Codes.
® Some barcodes may be unreadable.

® Barcodes may not be correctly read owing to scratch, dirt, damage,
quality of printed material, light reflection, or QR code version.

@ Barcode recognition may be slow. Hold handset steady while scanning.
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IViewingIEditing Scanned Data

Main Menu P> Tools P> Bar Code Reader
) Saved Data List

View

Select an item

Edit Title
Highlight an item = (x7)[Menu] — Edlit title — Edit
I Delete Saved Data

> In Step 1, (highlight an item —) [Menu] — Delete = Delete this
or Delete all (— For Delete all, enter Phone Password) = YES

13-16

I Using Scanned Data

Main Menu P> Tools P> Bar Code Reader
) Saved Data List

1 Select an item

2 (¥7)[Menu] = Select an item (See below)

Item Operation/Description
Save result  Save scanned results
Display list  Display Saved Data List
Internet Access website
> Yahoo! Keitai or PC Site Browser = YES
® Alternatively, select the URL.
Compose Insert address to message recipient field (C% From Step 4
message on P.14-4)
® Alternatively, select the address.
Dialing Call selected phone number
> Select a dialing method — Dial
® Alternatively, select phone number to dial.
Add to Save scanned results to Phone Book (C% From Step 2 on
Phone Book P.4-5)
Add Save URL to Bookmark
bookmark > YES - (@)[OK]
Copy Copy selected characters to another place (£ From Step

2 on P3-10)
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Basics
Send messages via S! Mail, SMS or PC Mail.
Exchange text messages with SoftBank or e-mail
S! Mail compatible handsets, PCs, etc.; attach image or
[Separate sound files etc.
subscription ® 942P is compatible with Graphic Mail
required)] (C%P.14-5)
® Send/receive up to 2 MB messages.
Exchange short text messages with SoftBank
SMS
handsets.
PC Mail
[Setup required] | Send/receive messages via PC mail account.
(CFP14-24)

® For more information, visit SOFTBANK MOBILE Corp. Website
(http:/www.softbank.jp).

Operations while Using PC Mail
Setting PC Mail accounts creates account folders in Messaging Folders.
S! Mail/SMS operations may change as a result (C3P.14-24).

® Messaging functions are also available in Horizontal Open Position.
Switching Normal Position to Horizontal Open Position may end active
screen.

\H

I Available Entry Items & Character Entry Limits

Item S! Mail/PC Mail SMS
E-mail o B _
2 | address Up to 246 single-byte
% Phone alphanumerics/ Up to 21 single-byte
a 12| O | Upto 20 recipients | O | alphanumerics/Up to
number "
1 recipient
Up to 256 double-
. byte/
Subject O Up to 512 single- - B
byte alphanumerics
Up to 70 double-/
Text O | 30KB O | single-byte
alphanumerics®
Attachment | O | *° - -

! SoftBank handset numbers only

2 Phone numbers cannot be used for PC Mail address.

3 When text entry mode is set to English (160char.) (L3 P.18-23), up to
160 single-byte alphanumerics can be entered.

* Up to 2 MB S! Mail including subject, message text and attachment.
Message size is changeable (Create Msg. Size: (% P.18-22)

> Up to 1 MB PC Mail including subject, message text and attachment.

® Character limit varies with attachment size.
® Change message type while creating a message (C5P.14-9).




I Messaging Folders & Memory Status

Messages are organized in folders by message type.
® PC Mail Folders: C%P.14-24

Messaging Folders

Incoming Mail

Receive Messages - 9  Received
= w1755 13
| |
"= = = = =9 Spam Folder

Create Messages
Save as Drafts
Send Messages Sent/Unsent

CompletelNotcompIeteI—:-) | sent/Unsent |

Ul -T2 13

! Set Auto-sort messages to specified folders or Spam Folder automatically
(CP.14-16, P.14-17).
2 Add up to ten folders (C%P.14-20).

Deleting Messages Automatically

When memory for messaging folders is low, old messages are
automatically deleted one by one. Protect important messages from
unintentional deletion (C%P.14-21), or set message deletion settings to
OFF (C%P.18-22). Messages in Drafts and SMS on USIM Card are not
deleted automatically.

When Messaging Memory is Full

H (Received Full) appears in Standby and no more new incoming
messages are received. Delete old messages in Incoming Mail folder
(C%P.14-22), then retrieve new messages (L% P.14-15).

M View Memory Status
> (=) > Memory Status

P eececcccccccccccccoccccoe
@Mail Security (CFP.12-11)

I Customizing Handset Address

Change your handset mail address (alphanumerics before @)
to reduce the risk of receiving spam. Default account name
is random alphanumerics.

abc123-xyz @ softbank.ne.jp
| Account | | Domain _|
Name Name

(Customize here)

® For details, visit SOFTBANK MOBILE Corp. Website
(http://www.softbank.jp).

® Handset mail address cannot be changed in Offline Mode.

® For operations while using Internet: L% P.15-6

1 —» Settings — Custom Mail Address

Handset connects to the Network.
Follow onscreen instructions.

Buibessa|y 3
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Sending S! Mail & SMS

I Sending S! Mail

® Text entry (C¥P3-2)

Example: Select a Phone Book entry to send S! Mail.

1 Pressand hold Mail size

Address field
Subject field
Attachment field
Text field

New S! Mail

2 Select Address field =&
Phone Book

[TPhone Book ___|MI
< FSent Address

Select a Phone Book entry =
Select a SoftBank handset number
or mail address

® Press (9 to toggle tabs if both mail
addresses and phone numbers are
saved.

w

d Ishikawa Saouro
el mn

4 Select Subject field =
Enter subject B |
| M <Input Text>
5 Select Text field
Enter text

TBD

~Add Art “Preview |

Text Entry Window

(=)[Send]

I am fi7 )

f the wlly I have
nch together this

ISaturday

® Alternatively, (&) — Create New to open Composition window.

P eececcccccccccccccccccoe

@Addresses @Additional Functions (L% P.14-8)
@Sending Options ((%P.14-10)
(ETTD @Request Delivery Confirmation (C%P.18-21)
@Set Reply-to Address @Set Signature (CP.18-22)

P
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Adding Attachments

After Step 6 on P.14-4, select
Attachment field

Long time no see. How
are you doina?

H I oy .
Select a folder in Data Folder = Ta=h§ iy th‘ ) tave
. uncl ogether [E3
Select a file aturday?”

3 (=)[Send]

By the Wly ). have
lunch together this
[Saturday?

I Attach Captured Pictures/Videos

> After Step1, Activate Camera — Photo mode or Video mode —
Frame subject = (@)[Record], (0D or (J)(x®) (= For video,
(@)[Stop], CO) or ()(xw)) —» (@)[Save], (0D or ()xw

® Some files can not be attached depending on the file format or size.

® Some copy protected files can not be sent.

® Attachments exceeding size limit are automatically compressed (Width
and height of compressed images may change.). If the compressed file
still exceeds maximum size, message cannot be sent.

® Ring Songs&Tones, Music and Videos files cannot be attached directly
from microSD Card. Move files to handset before attaching to
messages.

P ecccccccccccccccccccee
@Attachments (C¥P.14-8)
(ETITD @Set Attachment Size (C%P.18-21)

Graphic Mail

Create HTML messages; select font color/size, background
color, or insert images, etc.

Example: Use various Templates to create Graphic Mail.

@ Change font size
® Scroll text

After Step 4 on P.14-4, (x7)[Menu] -
Load Template — Highlight a template —»
(=)[View] = (@)

° to return to Template list.

2 Select Text field = Delete "z - lcxxE=LNTHR !

— Font Size " ) 14
® Alternatively, (x7)[Menu] = & ?
Set Graphic Mail to open Graphic é
Palette Font| Size T8
abete  [EI9978/30720mm
Graphic Palette
/AETITTE 145

g=
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Select a font size = Enter text

—> Select area

Place cursor before a sentence
to scroll = @[Start] — Move
cursor to end of sentence —

(®J[End]

Text is highlighted.
® To cancel selection: (@)

Set Scrolling - (x7)[Exit]

4] to preview —»

® Alternatively, (7)[Menu] =
Preview to view text field

(@) = [@)[Send]

I Reset Operations

> To cancel previous operation: Close Graphic Palette = (x7)[Menu] —
Undo

> To reset all Graphic Mail operations: — Graphic all reset — YES —
YES

M Use Mail Art
> In text entry window, — Mail Art = Select an item — [Exit]

M Use Files Saved in microSD Card
> In text entry window, — Insert files — File Select -
Select a folder — (&)[microSD] — Select a folder = Select a file

Tio EEEEEEXEEXEEXEEEEFFF XXX XX)

@Use Other Graphic Mail Settings (C%P.14-9)
@Download Templates via Internet (L3 P.14-10)



I Sending SMS Messages

® Text entry ((¥P3-2)
Example: Select a Phone Book entry to se

1 g Address field —

Create New SMS
Text field —[

Select Address field =
Phone Book

Select a Phone Book entry —»
Select a SoftBank handset number

nd SMS.

(= <Add Address>

£ _M<Input Text>

TBD

e ec

Composition Window

(= <Add Address>

= Destination Address
HSent Address
ElReceived Address

“'TBD

Phone Book

4 Select Text field
5 Enter text

® \When number of entered character
exceeds limit, S! Mail conversion option
message appears.

6 ([&send] TBD

etk E70/7000]
Menu
i

Text Entry Window

® \When a single-byte text message including | {} [ ]~/ is sent or a draft
including such text is edited, some characters may be cut out of text
field.

PP ececcccccccccccccccccoe

@Addresses @Additional Functions (C% P.14-8)

(TETTD @Request Delivery Confirmation (L% P.18-21)
@Change SMS Center Number @Set Input Character to English
(P18-23)

Buibessapy .
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I Creating Messages

Addresses

((From B Composition window, select Address field

M Enter Address Directly

> S! Mail: Address Input or Phone Number Input — Enter a mail
address/SoftBank handset number

> SMS: Direct Entry — Enter a SoftBank handset number

M Select Address from Sent Address/Received Address Logs
> Sent Address or Received Address — Select a log

I Select S! Mail Address from Mail Group
> Mail Group — Select a Mail Group

M Add/Edit/Delete Address
> Follow the steps (See below)

Item Operation/Description
14 Add > <Not entered> — Search/enter address —» Select an
recipients* address or enter directly

? Edit > Select an address — Edit (For SMS: Direct Entry) —
g Edit address
< Delete” > Highlight an address = (x7)[Menu] —
< Delete receiver — YES

* S Mail only

I Change To/Cc/Bcc (S! Mail only)

> Highlight an address = (x7)[Menu] = Destination types — Select a

type

14-8
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Attachments

[(From ] After attaching a file, select Attachment field

[ Open/Play Attached Files
> Select afile

M Add Attachments
> (x7)[Menu] = Add Attached Files — Select a folder — Select a file =
(&)[Finish]

® To capture still images or videos to attach: L3 P.14-5

M Delete Attachments
> Highlight a file = (37)[Menu] = Del Attached Files - YES

Additional Functions

M Look Up Words from Text Entry Window

> In S! Mail text entry window, (%7)[Menu] = Look up in dict.
— Move cursor before/after word — (@)[Start] = (9 to highlight the
word —» (@)[End] —» Read disclaimer = OK

® Dictionary operations: [3P.13-13



M Functions Available in Composition Window
> In Composition window, (x7)[Menu] = Select an item (See below)

Item Operation/Description
Send Send message
Preview Preview message
Save as Save message to Drafts box without sending
Drafts
Attached files' View attached file list
Load > Select a template
Template'
Save Save edited template
Template' >YES
Add Add signature

Signature' ® Create and save signature beforehand (L3 P.18-22).

\H

I Graphic Mail Functions

I Use Other Graphic Mail Settings
> In S! Mail text entry window, —» Select an arrange item (See below)

Item

Operation/Description

Insert files

Insert still images, music or Flash® files; activate Camera
and insert captured image
Music files are sent as BGM
> Select an item
- File Select — Select a file type = Select a folder

Send Settings' (C5P.14-10)

Image Set image compression size for attachment
Compression' > Select a size or OFF

Create Msg. 300KB or 2MB

Size'

Confirm (C%P.14-10)

Delivery?

Input Select character input mode

character’ > Japanese or English

— Select a file
- Camera —» Frame subject = (@)[Record] —
(e)[Save]
@ To delete inserted music files: Delete BGM — YES
Font Color > Change font color
Background > Change background color
color
Insert Lines  Insert separator line
Mail Art Insert Mail Art
> Select a file
Graphicall  Cancel all Graphic Mail Settings
reset >YES

Change mail  Switch mail type
type > Select an item

!SI Mail only
2 SMS only

Select area

Specify text to be arranged

> Place cursor before/after text — (@)[Start] =
99 to highlight area — (@)[End] —> Select other
items — Follow the steps for selected items

® To cancel selection: (@)[End] — (@)

Buibessa|y 3

Font Size

> Change font size
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Item Operation/Description

Select Flash text
Blinking

Set Scrolling  Scroll text

Set Swinging Swing text

Alignment > Select a type

® One file of music or Flash®, and up to 40 types of My Pictograms or
images can be inserted per Graphic Mail.

® To delete inserted images, lines, Mail Art, etc.: Close Graphic Palette —
Move cursor before images, etc. =

@ Ring Songs&Tones or Music files cannot be inserted directly from
microSD Card. Move files to handset beforehand.

I Save Edited Templates
> In S! Mail Composition window, (x7)[Menu] = Save Template —
YES

M Download Templates via Internet
> (=) - Templates - Download Templates — YES
® Handset connects to the Network. Follow onscreen instructions.

14-10
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I Sending Options

(From » Composition window, (¥7)[Menu]

I Confirm Delivery
> (For S! Mail, Send Settings —) Confirm Delivery — ON
® Request Delivery Confirmation (C%P.18-21)

I Notify Recipients of Message Priority Level (S! Mail only)
> Send Settings —» Priority — Select a level

I Set Reply-to Address (S! Mail only)
> Send Settings —» Set Reply-To = ON
® Specify reply-to address beforehand (L% P.18-22)



Receiving & Viewing Messages

Retrieving S! Mail Automatically

Auto Download retrieves up to 1 MB messages. Transmission fees are
incurred; adjust to use. (To disable Auto Download/limit message size for
Auto Download: C%P.18-22)

I Opening New Messages

i 8 E]

2/ 5(Frl]1D:1DI

When a new message is received,
M and Event Indicator appear in
Standby.

LZ2010/2/5 10:10
Fuaill Suzuki Goro
sulilllel lo

LMo Attachment File

1 Select indicator

Newest message appears.

® (0 to show previous/next message.

lLong time no see  How

lare you fo ¥

[ am firll Bed b

B{ the way, can we have
unch together this

[Baturday?

Message Window

® Handset may connect to the Network via URL link in message text.
Data-intensive web pages may incur high charges.

® Message tone and Notification Light may not always sound/illuminate.
M flashes and tone sounds to inform of a new message.

® Event Indicator disappears even when an unread message other than

latest message is selected.

PP eececcccccccccccccccccoe

@Retrieving/Viewing Messages (C5P.14-15)

@Setting Secret Mail (C%P.12-11)

(ETID @Change Ringtone @Change Ringer Volume @Set Message
Ringtone Duration @Set Vibration Alert (C%P.18-2)
@Set Notification Light by Incoming Type (Voice/Video Calls or
Messages) (CFP.18-10)
@Limit Maximum Incoming Message Size @Limit Auto-retrieval
by Message Type (C3P.18-22)

Buibessapy .
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I Window Description

I Messaging Folder Contents

. _— Received
Received Date & Time', . C Suzut Goro
Sender? and S! Mail Subject e o
(For SMS, Message Text) 2 U 3 Shirata Henaky

3 2.-" 5 Suzuki Goro

4 UTBDam

5 2.-" 5 Shirato Hanako
How are you?

@ For Sent/Unsent box, following

appear:
' Sent date/time Example: Received Folder
? Recipient in Incoming Mail
Message Type/Status
Message Type Message Status

-~/ Unread/Read S! Mail

'/ ® Unread/Read S! Mail
Notice

-/ ® Unread/Read SMS

-2/ ® Unread/Read USIM
Card SMS

- Forwarded Server Mail

Attachments
(Silver) Protected
Forwarded Message
Replied Message

Sending failed
(Sent/Unsent Message)

New Delivery Report
(Sent/Unsent Message)

High Priority

0 W X9 A me¢

Low Priority

14-12
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I Message Contents

Sent or Received

Date/Time Number/All Sent or
Sender/Recipient Received Messages
Subject

_ﬂlla Attachment File

ong time nn see  How
are you oy

Message Text
{ the way. can we have
u

nch together this
[Saturd

Message Window

Number of Attachments
The number of files (images, sounds, videos, text, etc.) appears.

_Note |

® Status indicators for forwarded/replied SMS messages (saved in USIM
Card) do not appear.

® After retrieving complete messages, S! Mail Notice icons with
IS (Forwarded) or W71 (Replied) change to (= / @ (SI Mail).

® Messages remain protected after complete messages are retrieved via
protected S! Mail Notices.

® |f messages on microSD Card do not appear correctly (C%P.10-20),
copy messages to handset (L3 P.10-21) and execute Charset
Conversion ((¥P.14-23).

P eceeccccccccccccccoccccoe
@Functions Available from Message Lists (C%P.14-21)

@Functions Available in Received/Sent Message Window (5 P.14-22)
ITHTD @Change Font Size (C%P.18-21)
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I Retrieving Complete S! Mail

The complete message may not be downloaded during
handset operations. Center sends initial portion of message
as an S! Mail Notice. Manually retrieve the complete
message.

. wm  Revd. Msg. 1/6
1 Select continue (xxxKB) at end of ZRa0/2/5 1010
. . Zuki ro
S! Mail Notice siiel lo

® (xxxKB) is an estimated Server Mail size; |-“8No Attachment File

may differ from actual message size. Long time oo seo  How

[are you go

I am firlk .

B{ the way, can “we_have
ui

nch together this

[Saturday? .
How about 12 o' clock at
19

I Retrieve from Message List
> In received message list, (x7)[Menu] = Retrieve — This one

I Retrieve Multiple Messages
> In received message list, (x7)[Menu] = Retrieve — Selected —
Check messages = (=)[Finish] - YES

I Opening & Saving Attachments

1 In Message window,

. _C2010/2/5 10:10
[Menu] — Attached files

Function 13

“{HReply
|ElReply with Quote

L d
PEeTBD

2 Select a file

File plays or shows.

3 After viewing,

Attached files window returns.

Bi [Add Address

IEI
[JAdd Shortcut Icon

4 Tosavethe file, highlight file —»
(=)[Save] > YES—»
Select a folder

® When messages are opened, attached image files appear/play
automatically.

® {3 (Silver) appears with file requiring a Content Key. If Content Key has 14
expired, warning appears when opening a file. Acquire new Content =
Key (C3P.10-5). 2
® Incompatible files are saved to Other Documents in Data Folder. Some é
files may not be saved to handset. é
File Formats Supported by Auto Playback
® |mage files (JPEG, GIF, PNG)
® Music files (SMAF, AMR, SMF, SP-MIDI)
P ececcccccccccccccoccccoe
(ETITD @Play Attached Music Files Automatically (T3 P.18-22)
14-13
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I Showing Sent/Received Mail Address I Using Server Mail

1 Sent Address Retrieve mail list stored at the Center to view Server Mail.

Press and hold (of

Received Address

Viewing Server Mail List

Press and hold (©) 1 —> Server Mail
S0 : Sus (successfully sent) 2 Retrieve Mail List - YES
[ENAL : S! Mail (successfully sent)

@ To show Redial/Incoming Call Logs: (@)[Change] M Update Server Mail List
2 To view entry details, select an entry > After Step1, Retrieve Mail List —» [Update] —> YES

® To send S! Mail/SMS to recipient shown: (] = Mail composition | Retrieving Server Mail
operation (S! Mail: % From Step 4 on P.14-4 or SMS: £ From . . Lo
Step 4 on P.14-7) 1 — Server Mail — Retrieve Mail List

® To save to Phone Book: (&)[Store] = Operation for saving to ® [f no Server Mail is in the list, YES = OK
Phone Book (L% From Step 2 on P.4-5) )
Retrieve a New Message

P ececcccccccccccccccccoce Select an S! Mail

@Sent/Received Address (C%P.14-20)
Retrieve Multiple Messages

(x7)[Menu] —» Retrieve — Retrieve Selected —»
Check messages — (=)[Finish] = YES

Buibessajy ;

I Retrieve All Messages
> (&) - Server Mail — Retrieve All
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Deleting Server Mail
1 —» Server Mail — Retrieve Mail List
2 (x7)[Menu] — Del Server Mail

3 Delete a Message
Delete This — YES

Delete Multiple Messages
Delete Selected — Check messages —» (=2)[Finish]
— YES
I Delete All Messages
> (=) - Server Mail — Delete All = Enter Phone Password —» YES
P ecccccccccccccccccccce

@Mail Security (CFP.12-11)
@Server Mail Functions (C% Right)

I Retrieving/Viewing Messages
Manually Retrieving New Messages

Retrieve S! Mail messages saved on Server while handset is off/out-of-range.
> (=) - Retrieve New

Server Mail functions

(From )p > Server Mail

M Forward Server Mail

> Retrieve Mail List — Highlight an S! Mail & (37)[Menu] -
Fwd Server Mail = Select Address field = Search/enter address —»
Select an address or enter directly = (=)[Send]

® To forward Server Mail from S! Mail Notice: In Message list, highlight
S! Mail Notice = [Menu] — Forward — Fwd Server Mail —
<Add Address> — Select/enter and address — (=)[Send]

® Forwarded S! Mail cannot be deleted from Server Mail List.

® ¥ appears for Server Mail saved to Drafts or Sent/Unsent after
forwarded.

M Sort Server Mail
> Retrieve Mail List - (x7)[Menu] = Sort — Select a condition

I View Server Mail Information
> Retrieve Mail List — Highlight a message = (37)[Menu] =
Mail Information

I View Server Mail Memory
> Server Mail Memory

Buibessa|y 3
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Organizing/Using Messages
IChecking Messages in Messaging Folders

® At time of purchase, information message is provided for your
convenience (Transmission fee does not apply).

1 — Incoming Mail, Drafts, ]
4 Nessaging

Sent/Unsent s Inconing Mail o
= Create New
= Retrieve New
w5 Drafts ]
L Te-m
W Sent/Unsent 1
B Server Mail
™ Create New PC Mail
£ Create New SNS
= Settings

ey

@ [[[E] appears for unread messages in
Incoming Mail folder.
U appears for draft or unsent messages
in Drafts or Sent/Unsent folder.

® |n Incoming Mail or Sent/Unsent folder,
select a folder then message.

® Messaging Folders: £ P.14-3

14 2 Select a message

? ® To toggle previous/next messages in Received/Sent Message

é. window: (o9

& P ecccccccccccccccccccce
@Functions Available in Incoming Mail or Sent/Unsent Folder (% P.14-20)
@Functions Available from Message Lists (C%P.14-21)

14-16
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I Auto-sort

Save messages that satisfy set conditions to designated

folder automatically.

® Previously sent/received messages are not sorted.

® Sent/received messages are sorted by subject if both address and subject
match sort condition applied to specific folder. Messages with no subject
are sorted by address.

® Either address or mail subject can be specified per folder.

1 — Incoming Mail or Sent/Unsent

Highlight a folder & (x7)[Menu] -
Auto-sort Setting

3 (@[Menu] - Select an item (See below)

Item Operation/Description

Add Address  Sort messages by address
> Search/enter address — Select/enter an address
® Save up to 10 addresses per folder.

Add Subject  Sort messages by mail subject
> Enter a subject
@ Save one subject per folder.

® SMS cannot be sorted by mail subject.

Add Group  Sort messages by Group in Phone Book
> Select a group
® Save up to 10 groups per folder.
Add Mail Sort messages by Mail Group
group > Select a Mail Group

® Save up to 10 Mail Groups per folder.




M Edit Sort Conditions
> After Step 2, highlight an item = (@)[Edit] = Edit address, subject or
Mail Group

Il Change Auto-sort List View
Switch Name view or Address view for Auto-sort.
> After Step 2, (&7)[Menu] = Display the List - Name or Address

[ Delete Auto-sort Settings
> After Step 2, (highlight an item —) [Menu] — Delete or
Delete All (= For Delete All, enter Phone Password) = YES

I Re-sort Set Folders

> To re-sort messages in a specific folder: In Step 2, highlight a folder =
(x7)[Menu] = Re-sort in This — YES

> To re-sort messages in all folders: After Step 1 = (37)[Menu] -
Sort in All > YES

\H

I Filter Spam

Sort messages from unknown senders into Spam Folder
without incoming notification. Use Safe List to receive
messages from certain addresses/phone numbers and
domains.

® Messages from secret Phone Book entries may be sorted into Spam

Folder. Be careful when deleting messages from Spam Folder.

Setting Spam Folder

<Default> OFF

—> Settings —» Universal Settings —»
Anti-Spam Measures

2 Spam Filter — Enter Phone Password

3 ON — YES

Buibessa|y 3
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Safe List

® Specify up to 20 addresses and domains (for example, @softbank.ne.jp)
to receive messages from without sorting into Spam Folder.

1 — Settings —» Universal Settings —
Anti-Spam Measures —> Safe List

2 Add Addresses
[Menu] —» Add Address = Received Address
or Direct Entry — Select or enter an address

Add Domains
(¥7)[Menu] = Add Domain — Enter a domain

3 (=)[Finish]

M Edit Saved Addresses
> After Step 1, highlight an address = (@)[Edit] — Edit address

14
M Delete Addresses
? > After Step 1, (highlight an address —) (x7)[Menu] = Delete or
é Delete All (= For Delete All, enter Phone Password) = YES
& P eececcccccccccccccoccccoe
@Report Spam (CFP.14-23)
14-18

I Replying to Messages
1 In Message window, [Reply]

® Re: appears before Subject when replying | S3Re. e}l
to S! Mail. Received message text is
quoted.

lLong t i 3 How
el B0

[ am fine as usual.

By the way, can we have
lunch together this

[Saturday?

409 Bytes|
[ Menu_|
Page V|

Total size:

Send
Page A

2 Complete message = (=2)[Send]

I Reply without Quoting

>1In Step 1, (7)[Menu] = Reply = Reply to Sender or Reply to All
—» Compose S! Mail or Compose SMS

® Selectable items differ by mail type.

® Alternatively, reply from Message List window without opening
messages (5 P.14-20)

P ececcccccccccccccccccece
@Quote Original Message in Reply (C3P.18-21)



I Using Mail Groups

Save mail addresses by group. Messages can be sent to
specified group of recipients.

@ Save up to 20 recipients per group.

® Create up to 20 groups.

Creating Mail Groups

Main Menu > Phone P> Settings > Mail Group

1 Selecta group to save

Enter Mail Address Directly
Highlight <Not stored> —
(=)[Edit] — Enter mail address

Select Mail Address from Phone
Book or Sent/Received Address Logs
Highlight <Not stored> —»
(x7)[Menu] = Look-up address

—» Select an item — Select an entry  mail Group List
@ Repeat Step 2 to save mail addresses.

E:ail Group 5
Gl 1.BD

EMail Group 10
EMai | Group 11
EMail Group 12
WMail Group 13

\H

Il Change Group Names
> In Step 1, highlight a Mail Group = (37)[Menu] =
Edit group name — Edit name

M Reset Group Names
> In Step 1, highlight a Mail Group = (37)[Menu] =
Reset group name — YES

M Edit Mail Addresses
> After Step 1, highlight a mail address — (=)[Edit] — Edit

M Delete Saved Mail Addresses

> After Step 1, (highlight a mail address —) (3)[Menu] —
Delete this or Delete all (= For Delete all, enter Phone Password) —»
YES

M Send a Message to All Group Members

> In Step 1, highlight a Mail Group = (=) IE=Il |
® To select a Mail Group from S! Mail Composition window: £ P.14-8

Buibessa|y ;
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I Sent/Received Address

> Sent address logs: Press and hold (o — Highlight an address —
[Menu] — Select an item (See below)

> Received address logs: Press and hold o) = Highlight an address —
[Menu] —> Select an item (See below)

\H

I Organizing Messages

I Functions Available in Incoming Mail or Sent/Unsent
Folder

> (=) = Incoming Mail or Sent/Unsent — (Highlight a folder) =
[Menu] —> Select an item (See below)

Item Operation/Description Item Operation/Description
Character Toggle font sizes Add folder  Add up to 10 user folders to each of Incoming Mail and
size Sent/Unsent folders
Add to Phone Save selected mail address/number to Phone Book > Enter folder name
Book (% From Step 2 on P.4-5) Edit folder > Edit folder name
Add shortcut Create a shortcut (% P.1-25) Select a shortcut in Standby name*
icon to open Composition window with selected mail address/ Auto-sort > Sort messages (% From Step 3 on P.14-16)
number in Address field Setting*
Compose Create a message to selected address/phone number Re-sort in Re-sort messages in selected folder
message (% From Step 4 on P.14-4) This >YES
Compose Create SMS to selected phone number (C3 From Step 4 Sort in All Re-sort messages in all folders
SMS on P.14-7) >YES
14 Dialing > Select a dialing method —» Dial Sort folder*  Sort user folders
Dialed calls’  Show Redial logs > Select a target location
? Received Show Incoming Call Logs Mail Security Set to require Phone Password for opening a folder
b calls? > Enter Phone Password
‘g. Delete this > YES ® To cancel: repeat the step
< Dol > Check logs to be deleted —» (=){Finish] - YES Delete folder* > Enter Phone Password — YES
selected *2A—Y—=T%)L% only
Delete all > Enter Phone Password —» YES
! Sent address logs only
2 Received address logs only
14-20



M Functions Available from Message Lists
> (&) = Incoming Mail, Drafts or Sent/Unsent (— Select a folder) =
Highlight a message = (37)[Menu] — Select an item (See below)

Item

Operation/Description

Forward’

> Forward or Fwd Server Mail — Select Address field
—» Search/enter address —» Select an address or enter
directly = (=2)[Send]

® Forward Server Mail (C%3P.14-15)

® When forwarding S! Mail, Fw: appears before Subject.
Dotted line appears in the first line of Text field.

@ Attachments are also forwarded (Messages with copy
protected attachments may not be forwardable.).

Dial

> Select an item —» Make a call/compose a message/add
to Phone Book

Add
Address'?

Save addresses to Phone Book
> Select phone number or mail address — YES
(% From Step 2 on P.4-5)

Item Operation/Description
Edit' ? Edit message to send
(S! Mail: £% From Step 2 on P.14-4/SMS: % From Step 2
on P.14-7)
Send? Send Drafts
Retrieve’ Retrieve complete S! Mail
> This one or Selected (— For Selected, check
messages —» (=)[Finish] = YES)
Reply? Reply without quoting message
> Reply to Sender or Reply to All = Select an item —»
Compose a message (S! Mail: T3 From Step 4 on P.14-4/
SMS: % From Step 4 on P.14-7)
® Selectable items differ by mail type.
Reply with  Quote received message to reply
Quote’ > Reply to Sender or Reply to All &

Select an item —» Compose a message (S! Mail:
% From Step 4 on P.14-4/SMS: % From Step 4 on
P.14-7)

® Selectable items differ by mail type.

Protect/
Unprotect'

Protect received/sent messages

> This one or Selected (— For Selected, check
messages —» (=)[Finish])

@ To unprotect, repeat the step.

® SMS saved in USIM Card cannot be deleted.

Unread/ Switch status to Unread/Read 14
Read’
Move'? Move messages to specific folders =
> Move This or Move Selected (— For ﬁ
Move Selected, check messages = (=)[Finish] & S
YES) — Select a folder «
@ SMS saved in USIM Card cannot be moved.
14-21
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Item Operation/Description I Using Messages
Delete > Select an item —» Operate selected item
® f messages are received while selecting multiple M Functions Available in Received/Sent Message Window
messages, message deletion may fail. > In Message window, (37)[Menu] — Select an item (See below)
Cor!firmw View Delivery report Item Operation/Description
LN Retrieve' Retrieve complete S! Mail
Send Ir data (C%P.11-3) Edit Edit messa
ge to send
Ic (FPI1) (S! Mail: % From Step 2 on P.14-4/SMS: [% From Step 2
Transmission on P.14-7)
quy to Copy messages to microSD Card Reply’ Reply without quoting message
microSD > YES > Reply to Sender or Reply to All - Select an item —»
Copy to USIM/ ~ Copy SMS to USIM Card/handset Compose a message (S! Mail: C% From Step 4 on
Copy to Phone® > YES P.14-4/SMS: % From Step 4 on P.14-7)
Move to Move SMS to USIM Card/handset ® Selectable items differ by mail type.
USIM/Move > YES Reply with  Quote received message to reply
to Phone’ Quote' > Reply to Sender or Reply to All -
Sort Change display order Select an item —» Compose a message (S! Mail:
> Select a display order % From Step 4 on P.14-4/SMS: (% From Step 4 on
Mail View detailed information (Subject, From, To, etc.) P.14-7)
14 Information ® Selectable items differ by mail type.
= Mail history'? Show up to 1000 sent/received mail records Forward' > Forward or Fwd Server Mail
a > Select a sender/recipient address ® Forward Server Mail ((3°P.14-15)
@ ® - or - appears. Dial > Select an item = Make a call/compose a message/add
a3 ® Select a record to show Message window. to to Phone Book
return to previous window. Add Address Save addresses to Phone Book
! Sent messages only > Select phone number or mail address = YES
2 Drafts only (& From Step 2 on P4-5)
3 Received messages only
14-22



Item Operation/Description Item Operation/Description
Add to Phone Save highlighted phone number/mail address to Phone Copy to Copy messages to microSD Card
Book Book microSD >YES

>YES
(% From Step 2 on P.4-5)

Attached files

Show attached files

Save
Templates

Save edited templates
>YES

Copy to USIM or  Copy SMS to USIM Card/handset
Copy to Phone' > YES

Move to USIM Move SMS to USIM Card/handset
or Move to >YES
Phone'

Add Shortcut
Icon

Create a shortcut (L3 P.1-25) Select a shortcut in Standby
to open Composition window with selected mail address/
number in Address field

Report Spam'  Report received mail as Spam

> (=)[Send]

® Change destination to report to (C3P.18-21).

Copy Copy address, subject or text
Select an item —= Copy (L% After Step 2 on P.3-10)
Look up in  Look up a word in dictionary
dict. > Move cursor before/after text = (@)[Start] & (o) to
highlight target area = (@)[End] = Read disclaimer
- 0K
® Dictionary operations (C%P.13-13)
Font Size > Select a size
Scroll Unit  Change scroll unit
> Select an item
Charset Convert characters when not properly shown
Conversion' > Select an item
Delete > Select an item — Operate selected item
Confirm View Delivery report
Delivery?
Mail View detailed information (Subject, From, To, etc.)
Information
Send Ir data (C%P.11-3)
1C (CFP.11-5)

Transmission

Mail history  Show up to 1000 sent/received mail records
> Select a sender/recipient address
® - or - appears.
@ Select a record to show Message window. to
return to previous window.

! Received Message window only
2 Sent Message window only

Buibessa|y 3
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PC Mail

Send/receive messages via PC mail account. Set PC mail
account in advance.
® Set Yahoo! Mail address: [ P.14-25

Notes

® Receiving PC Mail for the first time after setting PC mail account may
incur high packet transmission fees.

@ Using auto-receive settings may incur high packet transmission fees.
Be careful when using handset abroad.

® Checking for new messages may slow down other functions.

® Checking for new messages incurs packet transmission fees even
when no new messages are received.

@ Single-byte katakana and pictographs are not supported in PC Mail.

Using S! Mail/SMS with PC Mail

S!'Mail/SMS operations may change after PC mail account setup.
Example:

® To create S! Mail: Press and hold - 5! Mail

14 ® To attach files to S! Mail: Highlight a file = Attach to message

= —> S! Mail

o ® To view received messages: (&) = Incoming Mail = S! Mail/SMS
é —» Select a folder — Select a message

iy

14-24
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I Messaging Folders

PC Mail folders are added in Incoming Mail and Sent/Unsent
folders once account setup is complete.
® (reate up to three PC Mail folders.
® PC Mail is not sorted as Spam Mail.

Messaging Folders

Incoming Mail Sent/Unsent
S! Mail/SMS S! Mail/SMS
| Received | | Sent/Unsent |

[1--721L5 13"

[1--721L5 13"

Spam Folder

Account Name (PC Mail)

Account Name (PC Mail)

| Received |

| Sent/Unsent |

[1-9—7215 1-3*]

[1-9—7115 1-3*]

* Add up to 10 21— —T = JLF (user folders): 5 P.14-20

@ Functions available in S! Mail/SMS (Auto-sort Setting, Mail Security,
etc.) are also available in PC Mail (Some unavailable functions do not
appear in menu).




I PC Mail Account Setup

Set up accounts to use PC Mail.

@ Set up to three PC mail accounts.

® Check ISP information in advance.

® PC Mail services may not be available depending on services, settings,
contract details for PC mail account.

® Set Quick Yahoo Mail is available for setting your Yahoo! account.

1 — Settings — PC Mail Settings —
Account Settings
2 <Not Recorded> — Select an item (See below)

Item Operation/Description
Account > Enter an account name
Name
Incoming > Select an item —» Enter/select an item
Options ® User Name, Password and Receiving Server are
required.
Sending > Select an item —» Enter/select an item
Options ® Mail Address and Sender Server are required.

@ To confirm settings: In Incoming Options/Sending Options window,
(=)[Confirmati] &

® After information is entered in Incoming Options/Sending Options,
to return to Account Settings window.

3 (&)[Finish] & OK

® To retrieve new messages immediately, select YES

\H

M Quick Yahoo! Mail Address Setup
> After Step 1, Set Quick Yahoo Mail — YES or NO
® Follow onscreen instructions.

I Set Default Account
> After Step 1, highlight an account = (37)[Menu] — Default account
® > appears for selected account.

I Delete Account
> After Step 1, highlight an account = (3)[Menu] —» Delete account
— Enter Phone Password —> YES

Tip KX EEEEFEFE NN NN NN NN NENNY)
@Reset All Incoming Message Logs @Delete All Server Mail (C% P.14-26)

I Sending PC Mail

® Default account (% Above) is automatically selected.

1 Pressand hold

Account field

- PC Mail 14
PC Mail Composition window appears. SB<lonit Terts ?
2 Compose a message and send TBD &
=
(C% After Step 2 on P.14-4) PC Mail @
Composition Window
M Change Account
> After Step 1, select Account field = Select an account
® Alternatively, open PC Mail Composition window from
—> Create New PC Mail
14-25
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I Retrieving/Viewing PC Mail

® |f auto-retrieve setting is on, open new PC Mail from Event Indicator:

FP14-11

PC Mail Indicators

.=/® Unread/read PC Mail
. /® Unread/read PC Mail (notice only)

\H

I PC Mail Functions

I Attach Image/Music Files
> Highlight a file = (37)[Menu] = Attach to message —» PC Mail —
Compose a message and send (L% After Step 2 on P.14-4)

I Reset All Incoming Message Logs

> (=) > Settings —» PC Mail Settings —» Account Settings —
Select an account —» Server Maintenance — Reset Mail Log —
YES

® When Center sends initial portion of PC Mail, manually retrieve the
complete message.

M Delete All Server Mail
> () > Settings —» PC Mail Settings —» Account Settings —»

Retrieving PC Mail by Account

1 — Retrieve New —» Select an account

Viewing Previously Retrieved PC Mail

1 — Incoming Mail = Select an account —»
Select a message

Tio EEEEEEXEEEXEEXEEEEFFEF XXX X)

GITD @Disable Auto-retrieval for New Messages @Set Auto-retrieval
Interval for New Messages @Automatically Retrieve New
Messages while Abroad @Disable Auto-retrieval between Set
Time Period (C%P.18-23)

14-26

Select an account —» Server Maintenance — Delete All — Enter
Phone Password = YES

® [f over 10001 messages are on your PC mail server, retrieving/deleting
messages from that PC Mail account is disabled.
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Getting Started

Access Yahoo! Keitai Mobile Internet and PC sites.

"Yahoo! Keitai" is both a SoftBank Mobile Internet service
and the SoftBank Mobile Internet portal.
View PC Internet websites via PC Site Browser.

Internet

Yahoo! Keitai
@ View Mobile Internet Websites (C5P.15-3)
@ Download image/sound files, etc. (C¥P.15-11)
@ Movies/Music Streaming (CFP.15-12)
@ Register S! Quick News (C5 P.8-4)

PC Sites

® View PC Sites (C%P.15-5)
@ Download still images (C%P.15-11)

® Separate subscription is required for Network access.
® For more information, visit SOFTBANK MOBILE Corp. Website
(http://www.softbank.jp).

Connecting Via Wi-Fi

Access the Internet via Wi-Fi. Once connection setup is complete, handset
automatically connects to that Wi-Fi network when within range.

® Wi-Fi: CFP11-11

@ Switch to 3G from Wi-Fi: £3P.15-13

@ Video Calls cannot be received while connecting to the Network.

Cache Memory

Retrieved information is temporarily saved in Cache

Memory.

When full, oldest is deleted first.

® Previously viewed pages may load from Cache Memory. To view the
latest, update information (L3 P.15-13).

® Cached items with expiry dates are deleted upon expiry.

® Information remains even after handset is disconnected from the
Network or handset power is turned off.

P ececcccccccccccccccccoe

ETTTD @Clear Cache @Delete Cookies (C5P.18-24)
@ |nitialize Browser (¥ P.18-25)
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SSL/TLS

SSL (Secure Sockets Layer) and TLS (Transport Layer Security)
are encryption protocols for secure Internet transmissions
of important/sensitive information such as credit card
numbers.

Server certificates are saved on handset ({3 P.18-25).

Notes

When a security notice appears, subscribers must decide for themselves
whether or not to open the page. SOFTBANK MOBILE Corp., VeriSign
Japan K.K., Cybertrust Japan Co., Ltd., Entrust Japan Co.,Ltd., GlobalSign
K.K., RSA Security Inc. and SECOM Trust Systems Co., Ltd. cannot be held
liable for any damages associated with the use of SSL and TLS.

Tip 0 0000000000 OCOGEOSGEOGEOSEOSOSOSONOS

GITTD @Security Settings (L% P.18-25)

Using Yahoo! Keitai
I Opening Yahoo! Keitai Menu

Select Yahoo! Keitai Menu items to access websites.

Main Menu P> Yahoo!

1
2

® Shortcut: In Standby, press

Open Top Menu
Yahoo! Keitai

Open Menu List
Menu List

Select a menu item

® Repeat Step 2 as required.
® Basic Operations: CFP.15-6

-—
H loulolu|
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I Entering URL

Enter URLs (addresses beginning with "http://" or "https://")
directly to access websites, or open previously viewed pages
using URL histories.

® Up to 20 URL histories are stored.

Main Menu P> Yahoo! p> Enter URL

Enter URL Directly
Direct Entry —» Enter URL

Use URL History

URL History List — gihttpiﬁm. ghijklmno
Select a URL El@http://www. abcdef. xx

TBD

URL History List
Window

M Delete URL Histories
> In Step1, URL History List = (Highlight a URL =) (%7)[Menu] -
Delete or Delete All - YES

I Using Access Histories

Open previously viewed pages using access histories.
® Up to 100 access histories are stored (The number of savable histories
varies depending on data amount.).

Main Menu p> Yahoo! > History

1 Selecta history

L11% Yahoo | @ E& 2= A 1iie |
El@ Yahoo! BRERINLR

El@ 2" -t 55
Eanik I -)-7" Bhid
EH@Yahoo! %

s BDs)

History Window
I Delete Access Histories

> In Step 1, (highlight a history =) (37)[Menu] —» Delete or
Delete All = YES (= For Delete All, enter Phone Password)

I Show Access History URLs
> In Step 1, highlight a history = (x7)[Menu] — Display URL

I Exiting Mobile Internet
1 & ->vEs

® Closing handset does not affect active browser.
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Using PC Site Browser

View PC websites using PC Site Browser.

@ When PC Site Browser is active, &l appears.

@ Some pages may not be viewable.

® Viewing PC websites may incur high charges.

® Opening PC Site Browser enables Touchpad. Touchpad Indicators
illuminate (Touchpad operations: £%P.1-23, P.1-24).

I Opening Menu
Main Menu P> Yahoo! > PC Site Browser
1 Homepage

Confirmation appears. Select NO.
® To show confirmation each time: YES

2 Selecta menu item
Repeat Step 2 as required.

® Alternatively, press (&) in Yahoo! Keitai Menu to switch to PC Site
Browser Menu. To return to Yahoo! Keitai Menu, press again.

P eececcccccccccccccccccoe

@ITTD @Set Touchpad to Activate for Web Browser/Mobile Widget
(C5P.18-7)
@Hide Warning Messages when Activating PC Site Browser or
Switching to Yahoo! Keitai (C%°P.18-24)

I Entering URL

Follow same operation accessed from Yahoo! Keitai.

Main Menu P> Yahoo! P> PC Site Browser »> Enter URL

® Follow Step 1 of same operation accessed from Yahoo! Keitai

(P.15-4).
I Using Access Histories

Follow same operation accessed from Yahoo! Keitai.

Main Menu P> Yahoo! P> PC Site Browser > History

® Follow Step 1 of same operation accessed from Yahoo! Keitai

(CFP.15-4).

I Exiting Internet
1 (=) > YES

® Closing handset does not affect active browser.

-—
H loulolu|
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Basic Operations

I Using Cursor

@ Operation descriptions are based on Portrait View.

\H

When Authentication is Required
Some pages require user authentication for access.
If required, enter user ID or password.

@ While page is open, press and hold (@) to switch to Digital TV,

Move Cursor

Use cursor to select underlined menu items.
(o to move right

(o) to move left

(B)to move to previous line

(2)to move to next line

P eecccccccccccccccccccoe
TETID @Font Size @Scroll Unit @Images Off @Sound Off @Delete
User ID or Password Entered when Authentication is Required

(C¥P.18-24)

Scroll Pages

Scroll bar appears on right side or at bottom of

Display when page content continues beyond

view.

@) scroll up/down

029 scroll left/right

(&) scroll page up by a screenful

(.9 scroll page down by a screenful

® To scroll continuously, press and hold above
keys.

Move to
previous page/
next page

—
H EIENT

Previously viewed pages are temporarily saved in

Cache Memory (C5P.15-2).

(=2)[Back]: Return to previous page

(x7)[Menu] = Forward"- View next page

® Some web pages may not appear after
performing the steps above.

@ Touchpad operations (C%P.1-23, P.1-24)

15-6




IText Entry & Item Selection

Enter text or select items to send information.

Example:
Text Entry
Field Radio Button
Menu List
Check Box
Command Button

® Actual web pages may differ in appearance.

Text Entry Field

Highlight field — (@) —» Enter text — (@)

Menu List

Highlight field = (@)

Menu list appears.

Highlight an item — (@)
Selected items are highlighted.

Radio Button

Highlight & — (e)
When selected, @ appears.

Check Box

Highlight (1 — (e}
When selected, ] appears.
Press (@) again to cancel selection.

Command Button

Highlight the button = (@)
Corresponding command is executed.

-—
H loulolu|
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Using Information
I Bookmarks & Saved Pages

Bookmark websites or save page content to Saved Pages.

® Some copy protected materials cannot be saved.

Save links to websites. Handset connects to the

g Network to open the link.

Save page content. Handset opens saved pages

e without connecting to the Network.

Saving Web Pages

Open a web page = (¥7)[Menu] =
Bookmarks or Saved Pages = Add

2 Select title = Edit title
3 0K - OK

\H

Viewing Bookmarks & Saved Pages

Main Menu P> Yahoo! (» PC Site Browser)

1 Bookmarks or Saved Pages — Select an item
Example: Yahoo! Keitai Browser

Saved Pages

L11% Panasonicd-A-4k |
ANi-FiITIERT
Eax1-)2p
DaSHlES B
BassSic

TBD

(IS Yahoo!ieieee |
H @ Yahoo! il FR3Z:E 1 38

TBD

Bookmarks List Window Saved Pages List Window

M Open Bookmarks/Saved Pages in Web Page
> Open a web page = (%7)[Menu] = Bookmarks or Saved Pages —
View List

® (reate folders in Bookmarks/Saved Pages List to organize Bookmarks/
Saved Pages (C%P.15-9).

P eececcccccccccccccoccccoe

@5end Bookmarks via Infrared (C5P.11-3)

@5end Bookmarks via IC Transmission (C%P.11-5)

@Add Bookmark Shortcuts to Standby @Save URLs to Bookmarks
@5Send Bookmark URLs (£%P.15-10)



I Managing Bookmarks & Saved Pages

Follow the steps below to open Bookmarks or Saved Pages
list:

M Yahoo! Keitai
Main Menu P> Yahoo! p> Bookmarks or Saved Pages
M PC Site Browser

Main Menu P> Yahoo! > PC Site Browser
»> Bookmarks or Saved Pages

® When a different USIM Card is inserted, Saved Pages do not appear or
title name cannot be changed.

Creating New Bookmarks/Saved Pages Folders
® Folders cannot be created within existing folders.

Bookmarks
In Bookmarks list window, (37)[Menu] —
Create New —» Folders — Enter title

Saved Pages
In Saved Pages list window, (¥7)[Menu] =
New Folder — Enter title

\H

B Move Bookmarks/Saved Pages to Folder

(@ Before moving to folders, set Sort to Saved/Used Order or
Saved/Moved Order (C%P.15-10)

@ In Bookmarks/Saved Pages list window (L% P.15-8), highlight a
bookmark/saved page = (37)[Menu] - Move to — Select a folder
— Select a destination

M Edit Folder Title
> In Bookmarks/Saved Pages list window (L3 P.15-8), highlight a folder =
(x7)[Menu] = Edit — Edit folder title

Editing Bookmark Titles/URLs

In Bookmarks list window, highlight a bookmark —»
(x7)[Menu] — Edit

2 Edit title/URL

Renaming Saved Pages

In Saved Pages list window, highlight a saved page =
(x7)[Menu] - Edit

2 Edit title

P ecccccccccccccccccccoe
@Delete Bookmarks/Saved Pages/Folders @Display Bookmark/Saved Page
URLs @Change Bookmarks/Saved Pages/Folders Display Order @Sort
Bookmarks/Saved Pages/Folders (C3P.15-10)

-—
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I Bookmarks/Saved Pages Functions

(From b Main Menu b Yahoo! (P> PC Site Browser)

p> Bookmarks or Saved Pages

I Add Bookmark Shortcuts to Standby
> Highlight a bookmark = (37)[Menu] = Add shortcut icon - YES

I Save URLs to Bookmarks
> (¥7)[Menu] = Create New = Bookmarks — Enter a title/URL =
oK

M Delete Bookmarks/Saved Pages/Folders
> Follow the steps below

\H

M Sort Bookmarks/Saved Pages/Folders
> (¥7)[Menu] = Sort — Select a condition

M Send Bookmark URLs

> Highlight a bookmark = (3z)[Menu] —> Send URL — S! Mail or
SMS —» Create a message (S! Mail: L% From Step 2 on P.14-4/SMS:
% From Step 2 on P.14-7)

Item Operation/Description
Delete > Highlight a bookmark, saved page or folder =
(¥7[Menu] = Delete —» YES
Delete Select items to delete

Selected Items > (x7)[Menu] = Delete selected — Check items to
delete & (37)[Delete] - YES

Delete Al > (/)[Menu] - Delete All - YES — Enter Phone

Password

M Display Bookmark/Saved Page URLs
> Highlight a bookmark/saved page = (37)[Menu] — Display URL

I Change Bookmarks/Saved Pages/Folders Display Order

> Highlight a bookmark/saved page/folder & (37)[Menu] - Move to —
&) to select a position

® Before changing order, set Sort (L3 Right) to Saved/Used Order or
Saved/Moved Order.

15-10
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I Downloading Image/Sound Files

Save images, sounds, etc. to Data Folder or microSD Card.
@ For PC Site Browser, only still images can be saved.

1 Open a web page = (¥7)[Menu] - Select File
2 Selecta file

File details appear.

3 Save = YES

Available menu items vary by saved content.

® Save location is determined by Save Settings (5 P.18-24).
However, save location may change depending on situations. Check
confirmation when download is complete.

I Using Number, Address or URL

Use linked numbers, addresses or URLs to make calls, send

messages, access websites, or save directly to Phone Book.

1 Opena web page containing phone numbers, mail
addresses or URLs

2 Phone Number
Select a phone number —» Select an item (See below)

® Do not remove/install microSD Card while saving files to it.

® Do not turn handset power off while downloading or saving files.
Files may be damaged.

® Some copy protected files may not be saved.

® Videos selected from web pages play while being downloaded.

® Files 10 MB and larger are saved to microSD Card regardless of

Item Operation/Description
Voice call Make a Voice Call
Video call Make a Video Call
Selectimage  Select outgoing image
Add to Phone  Save a number to Phone Book (C% From Step 2 on
Book P.4-5)

E-mail Address
Select an address = Select an item (See below)

-—
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settings.

Item Operation/Description
Compose Create S! Mail (C% From Step 4 on P.14-4)
S! Mail

Compose SMS  Create SMS (L5 From Step 4 on P.14-7)

Add to Save mail address to Phone Book (L From Step 2 on
Phone Book P.4-5)

URL

Select URL

Handset connects to the Network.
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I Streaming

® Supported by compatible files on Yahoo! Keitai sites only.
@ Streaming files cannot be saved.

Main Menu P> Yahoo! P> Yahoo! Keitai

1 Opena web page —» Select a file
Streaming starts.

2 or to exit
I Engaged Streaming Operations

® Streaming requires a continuous Network connection. Network remains
connected even during a pause (Transmission fees apply).

® Paused streams may stop after three minutes of inactivity.

® Pausing playback while streaming via Wi-Fi (handset closed) may end
streaming after 10 seconds.

® \When roaming abroad, streaming may be unavailable or not be
performed properly.

Mute/Release Mute | ()] IESN/ KT

Pause/Resume* (o) [T/ |

Volume B/Em

Set Playback (99 to start playback from specified point
Position™

Toggle Views @)

® Toggle: Portrait View —» Landscape View (Fit to|

Display size) = Full-size Landscape View

—
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* Not available during playback for live events such as live sports programs
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Incoming Voice Calls while Streaming
Incoming call pauses an active stream.
® Video Calls cannot be received while streaming.




Option Menu Items

In Yahoo! Keitai, press (x7)[Menu] for these options:
® Some functions may not be available depending on web pages.

Item Operation/Description
Forward Go to next page ([ P.15-6)
Bookmarks View Bookmarks list, add bookmarks, or add bookmark

shortcuts to Standby

Item Operation/Description
Yahoo! Keitai'/ View top menu
Home Page’
Settings Font Size: Change font size

Encoding: Change encoding type
Pointer: Set Pointer?

Switch screen? Toggle between Small Screen and PC Screen

Exit Browser  Exit Browser

Saved Pages

View Saved Pages list or save page content to Saved
Pages

Text Copy Copy page text

Reload Page  Refresh page information

Enter URL Enter URL directly or use URL History to access pages

Select File View, play or save file to Data Folder (Downloading
Image/Sound Files: C% From Step 2 on P.15-11)

Handy Switch PC Browser'/Switch Browser’: Toggle

Functions Yahoo! Keitai/PC site

Connect to Wi-Fi/Connect to 3G: Toggle Wi-Fi/3G
connection

Internet Search: Search text in Internet

Look up in dict.: Look up specified text in dictionary
Search In Page: Search text within page

Jump in this page: Jump to top/end of page

Send URL: Send URL via S! Mail/SMS

History: Open previously viewed pages
Expand/Shrink?: Zoom page in/out

Set Display Range”: Specify displayed area of page
Flash(R) Menu: Playback/pause Flash® files
Properties: View page details or server certificates for
secure pages

' Yahoo! Keitai only
2 PC Site Browser only

-—
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